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본 설명서 정보

경고! 지시 사항을 따르지 않으면 부상을 당하거나 생명을 잃을 수 있습니다.

주의: 지시 사항을 따르지 않으면 장비가 손상되거나 정보가 유실될 수 있습니다.

주: 이런 텍스트는 중요한 추가 정보를 제공합니다.
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1 컴퓨터 진단 기능

HP Insight Diagnostics
주: HP Insight Diagnostics 는 일부 컴퓨터 모델에만 제공되는 CD 에 있습니다.

HP Insight Diagnostics 유틸리티를 사용하면 컴퓨터의 하드웨어 구성 정보를 볼 수 있고 컴퓨터의 하
위 시스템에서 하드웨어 진단 테스트를 수행할 수 있습니다. 이 유틸리티는 하드웨어 문제를 효율적으
로 확인, 진단 및 해결할 수 있도록 프로세스를 단순화합니다.

HP Insight Diagnostics 를 실행하면 Survey(조사) 탭이 표시됩니다. 이 탭은 컴퓨터의 현재 구성을 나
타냅니다. Survey(조사) 탭에서는 컴퓨터에 대한 정보를 몇 개의 범주별로 볼 수 있습니다. 다른 탭은
진단 테스트 옵션 및 테스트 결과를 포함하여 추가 정보를 제공합니다. 유틸리티의 각 화면에 대한 정
보는 html 파일로 저장하거나 디스켓 또는 USB HP 드라이브 키로 저장할 수 있습니다.

HP Insight Diagnostics 를 사용하여 컴퓨터에 설치된 모든 장치가 시스템에 의해 인식되고 제대로 작
동하고 있는지 확인할 수 있습니다. 테스트 실행 여부는 선택 사항이지만 새 장치를 설치하거나 연결
한 다음 테스트를 실행하는 것이 좋습니다.

고객 지원 센터에 문의하기 전에 인쇄된 보고서를 사용할 수 있도록 테스트를 실행하고 테스트 결과를
저장하고 인쇄하십시오.

주: 타사 장치는 HP Insight Diagnostics 에서 인식되지 않을 수도 있습니다.

HP Insight Diagnostics 액세스

HP Insight Diagnostics 에 액세스하려면 아래 단계에서 설명된 것처럼 Documentation and
Diagnostics CD 로 부팅해야 합니다.

1. 컴퓨터가 켜져 있는 상태에서 컴퓨터의 광 드라이브에 Documentation and Diagnostics CD 를 삽
입합니다.

2. 운영체제를 종료하고 컴퓨터의 전원을 끕니다.

3. 컴퓨터의 전원을 켭니다. 시스템을 CD 로 부팅합니다.

주: 시스템이 광 드라이브의 CD 로 부팅되지 않는 경우 하드 드라이브로 부팅하기 전에
광 드라이브로 부팅을 시도하도록 Computer Setup(F10) 유틸리티의 부팅 순서를 변경해
야 할 수도 있습니다. 자세한 내용은 Documentation and Diagnostics CD 의 Computer
Setup(F10) 유틸리티 설명서를 참조하십시오.

4. 해당 언어를 선택하고 Continue(계속)를 누릅니다.
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주: 특정 키보드를 테스트하지 않을 경우 해당 언어에 할당된 기본 키보드를 사용하는 것
이 좋습니다.

5. 최종 사용자 라이센스 계약 페이지에서 라이센스 조항에 동의하는 경우 Agree(동의)를 누릅니
다. HP Insight Diagnostics 유틸리티는 Survey(조사) 탭이 표시된 상태에서 실행됩니다.

Survey(조사) 탭
Survey(조사) 탭은 중요한 시스템 구성 정보를 표시합니다.

View level(보기 수준) 필드에서 Summary(요약) 보기를 선택하면 제한된 구성 데이터가 표시되고
Advanced(고급) 보기를 선택하면 선택한 범주의 모든 데이터가 표시됩니다.

Category(범주) 필드에서는 다음과 같은 정보 범주를 선택하여 표시할 수 있습니다.

All(모두) — 컴퓨터에 대한 모든 범주의 정보 목록을 제공합니다.

Overview(개요) — 컴퓨터에 대한 일반적인 정보 목록을 제공합니다.

Architecture(아키텍처) — 시스템 BIOS 및 PCI 장치 정보를 제공합니다.

Asset Control(자산 제어) — 자산 태그, 시스템 일련 번호 및 프로세서 정보를 나타냅니다.

Communication(통신) — 컴퓨터 병렬(LPT) 및 직렬(COM) 포트 설정에 대한 정보와 USB 및 네트워
크 컨트롤러 정보를 나타냅니다.

Graphics(그래픽) — 컴퓨터의 그래픽 컨트롤러에 대한 정보를 나타냅니다.

Input Devices(입력 장치) — 키보드, 마우스 및 컴퓨터에 연결된 기타 입력 장치에 대한 정보를 나타
냅니다.

Memory(메모리) — 컴퓨터의 모든 메모리에 대한 정보를 나타냅니다. 여기에는 시스템 보드의 메모리
슬롯 및 메모리 모듈이 설치된 경우 해당 모듈도 포함됩니다.

Miscellaneous(기타) — 컴퓨터 구성 메모리(CMOS)에서 획득한 정보, 시스템 관리 BIOS 데이터, 시
스템 보드 데이터 및 진단 구성 요소 정보를 나타냅니다.

Storage(저장 장치) — 컴퓨터에 연결된 저장 매체에 대한 정보를 나타냅니다. 이 목록에는 모든 고정
디스크, 디스켓 드라이브 및 광 드라이브가 포함됩니다.

System(시스템) — 컴퓨터 보드, 프로세서, 섀시 및 BIOS 에 대한 정보와 내부 스피커 및 PCI 버스 정
보를 나타냅니다.

Test(테스트) 탭
Test(테스트) 탭에서 시스템의 다양한 부품을 선택하여 테스트할 수 있습니다. 테스트 유형 및 테스트
모드를 선택할 수도 있습니다.
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선택할 수 있는 테스트 유형은 다음 세 가지가 있습니다.

● Quick Test(빠른 테스트) — 각 하드웨어 구성 요소의 샘플을 테스트하는 사전 정의된 스크립트
를 제공하고 무인 모드 또는 대화식 모드에서는 사용자의 개입이 필요하지 않습니다.

● Complete Test(전체 테스트) — 각 하드웨어 구성 요소 전체를 테스트하는 사전 정의된 스크립트
를 제공합니다. 대화식 모드에서는 더 많은 테스트를 사용할 수 있지만 사용자의 개입이 필요합
니다.

● Custom Test(사용자 정의 테스트) — 시스템의 테스트 제어 부분에서 가장 뛰어난 유연성을 제공
합니다. 사용자 정의 테스트 모드에서는 실행할 장치, 테스트 및 테스트 매개변수를 선택할 수 있
습니다.

각 테스트 유형에서는 다음 두 가지 테스트 모드 중에서 선택할 수 있습니다.

● Interactive Mode(대화식 모드) — 테스트 과정을 최대한 제어할 수 있습니다. 테스트 중 사용자
의 개입이 필요한 정보의 입력을 요구하는 메시지가 표시됩니다. 테스트의 성공 또는 실패 여부
를 확인할 수도 있습니다.

● Unattended Mode(무인 모드) — 메시지가 표시되지 않고 사용자의 개입이 필요 없습니다. 오류
가 발견되면 테스트 완료 후 화면에 표시됩니다.

테스트를 시작하려면 다음과 같이 하십시오.

1. Test(테스트) 탭을 선택합니다.

2. 실행하려는 테스트 유형에 대한 탭을 선택합니다. Quick(빠른 테스트), Complete(전체 테스트)
또는 Custom(사용자 지정 테스트) 중에서 선택할 수 있습니다.

3. Test Mode(테스트 모드)를 선택합니다. Interactive(대화식 모드) 또는 Unattended(무인 모드) 중
에서 선택할 수 있습니다.

4. 테스트를 실행할 방법, 즉 Number of Loops(반복 횟수)또는 Total Test Time(총 테스트 시간)을
선택합니다. 지정된 반복 횟수 이상 테스트를 실행하도록 선택한 경우 수행할 반복 횟수를 입력
합니다. 지정된 시간 동안 진단 테스트를 실행하려는 경우 시간(분)을 입력합니다.

5. Quick Test(빠른 테스트) 또는 Complete Test(전체 테스트)를 수행 중인 경우 드롭다운 목록에서
테스트할 장치를 선택합니다. Custom Test(사용자 지정 테스트)를 수행 중인 경우 Expand(확
장) 버튼을 눌러서 테스트할 장치를 선택하거나 Check All(모두 선택) 버튼을 눌러서 모든 장치를
선택합니다.

6. 테스트를 시작하려면 화면의 오른쪽 하단 모서리에서 Begin Testing(테스트 시작) 버튼을 누릅니
다. 테스트 과정 중에 테스트의 진행 상태를 모니터링할 수 있는 Status(상태) 탭이 자동으로 표시
됩니다. 테스트가 완료되면 Status(상태) 탭은 장치의 성공 또는 실패 여부를 나타냅니다.

7. 오류가 발견되면 Log(로그) 탭으로 이동하여 Error Log(오류 로그)를 눌러 자세한 정보 및 권장
조치를 확인합니다.

Status(상태) 탭
Status(상태) 탭은 선택한 테스트의 상태를 표시합니다. 실행된 테스트 유형(Quick(빠른 테스트),
Complete(전체 테스트) 또는 Custom(사용자 정의 테스트))도 표시됩니다. 기본 진행 표시줄에는 현재
테스트의 완료율이 표시됩니다. 진행 중인 테스트를 취소할 경우에 사용할 수 있는 Cancel Testing(테
스트 취소) 버튼이 표시됩니다.

테스트가 완료된 후 Cancel Testing(테스트 취소) 버튼은 Retest(다시 테스트) 버튼으로 대체됩니다.
Retest(다시 테스트) 버튼은 실행된 마지막 테스트를 다시 테스트합니다. 이 버튼을 사용하면 Test(테
스트) 탭에 데이터를 다시 입력하지 않고도 테스트를 다시 실행할 수 있습니다.
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Status(상태) 탭은 다음 항목도 나타냅니다.

● 테스트 중인 장치

● 테스트 중인 각 장치의 테스트 상태(실행 중, 성공 또는 실패)

● 테스트 중인 모든 장치의 전체 테스트 진행률

● 테스트 중인 각 장치의 테스트 진행률

● 테스트 중인 각 장치의 테스트 경과 시간

Log(로그) 탭
Log(로그) 탭에는 Test Log(테스트 로그) 탭과 Error Log(오류 로그) 탭이 있습니다.

Test Log(테스트 로그)는 실행된 모든 테스트, 실행 횟수, 실패한 테스트 횟수 및 테스트를 완료하는 데
소요된 시간을 표시합니다. Clear Test Log(테스트 로그 삭제) 버튼은 Test Log(테스트 로그)의 내용
을 삭제합니다.

Error Log(오류 로그)는 진단 테스트 중에 실패한 장치에 대한 테스트를 표시하고 다음 정보 열이 포함
됩니다.

● Device(장치) 섹션은 테스트한 장치를 표시합니다.

● Test(테스트) 섹션은 실행한 테스트 유형을 표시합니다.

● Description(설명) 섹션은 진단 테스트에서 발견된 오류를 설명합니다.

● Recommended Repair(권장 복구)는 하드웨어를 해결하기 위해 수행해야 하는 권장 조치를 제공
합니다.

● Failed Count(실패 횟수)는 실패한 테스트 횟수입니다.

● Error Code(오류 코드)는 실패에 대한 숫자 코드를 제공합니다. 오류 코드는 Help(도움말) 탭에
정의되어 있습니다.

Clear Error Log(오류 로그 삭제) 버튼은 오류 로그의 내용을 삭제합니다.

Help(도움말) 탭
Help(도움말) 탭에는 HP Insight Diagnostics 탭, Error Codes(오류 코드) 탭 및 Test Components
(테스트 구성 요소) 탭이 있습니다.

HP Insight Diagnostics 탭에는 도움말 항목이 있으며 검색 및 색인 기능이 포함됩니다.

Error Codes(오류 코드) 탭은 Log(로그) 탭에 있는 Error Log(오류 로그) 탭에 표시될 수 있는 각 숫자
오류 코드의 설명을 제공합니다. 각 코드에는 해당하는 오류 Message(메시지) 및 문제 해결에 도움이
되는 Recommended Repair(권장 복구) 작업이 있습니다. 오류 코드 설명을 신속하게 찾으려면 탭 상
단의 상자에 코드를 입력하고 Find Error Codes(오류 코드 찾기) 버튼을 누릅니다.

Test Components(테스트 구성 요소) 탭은 실행되는 테스트에 대한 하위 수준의 정보를 표시합니다.
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HP Insight Diagnostics 의 정보 저장 및 인쇄

HP Insight Diagnostics Survey(조사) 및 Log(로그) 탭에 표시된 정보를 디스켓 또는 USB 2.0 HP 드라
이브 키(64MB 이상)에 저장할 수 있습니다. 하드 드라이브에는 저장할 수 없습니다. 시스템은 화면에
표시된 정보와 동일한 html 파일을 자동으로 생성합니다.

1. 디스켓 또는 USB 2.0 HP 드라이브 키(용량이 64MB 이상인 경우)를 삽입합니다. USB 1.0 드라이
브 키는 지원되지 않습니다.

2. 화면의 오른쪽 하단 모서리에 있는 Save(저장)를 누릅니다.

3. Save to the floppy(플로피에 저장) 또는 Save to USB key(USB 키에 저장)를 선택합니다.

4. File Name(파일 이름) 상자에 파일 이름을 입력하고 Save(저장) 버튼을 누릅니다. 삽입한 디스켓
또는 USB HP 드라이브 키에 html 파일이 저장됩니다.

주: html 파일이 미디어에 기록되었다는 메시지가 표시될 때까지 디스켓 또는 USB 키를
분리하지 마십시오.

5. 정보를 저장하는 데 사용된 저장 장치에서 정보를 인쇄합니다.

주: HP Insight Diagnostics 를 종료하려면 화면의 왼쪽 상단 모서리에서 Exit Diagnostics(진단
종료) 버튼을 누른 다음 광 드라이브에서 Documentation and Diagnostics CD 를 꺼냅니다.

HP Insight Diagnostics 의 최신 버전 다운로드

1. http://www.hp.com 으로 이동합니다.

2. Software & Driver Downloads(소프트웨어 및 드라이버 다운로드) 링크를 누릅니다.

3. 텍스트 상자에 제품 번호(예: dc7700)를 입력하고 enter 키를 누릅니다.

4. 컴퓨터 모델을 선택합니다.

5. OS(운영체제)를 선택합니다.

6. Diagnostic(진단) 링크를 누릅니다.

7. HP Insight Diagnostics Offline Edition 을 누릅니다.

8. 언어를 선택하고 Download(다운로드)를 누릅니다.

주: 다운로드에는 부팅 CD 를 생성하는 방법에 대한 지침이 포함되어 있습니다.

소프트웨어 보호
소프트웨어의 손실 및 손상을 방지하려면 모든 시스템 소프트웨어, 응용프로그램 및 하드 드라이브에
저장된 관련 파일을 백업해 두십시오. 데이터 파일의 백업본 작성에 대한 지침은 운영체제 설명서나 백
업 유틸리티 설명서를 참조하십시오.
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HP Backup and Recovery Manager
주: 아래에 설명된 기능은 Microsoft Windows XP 가 설치되어 있는 시스템에서만 사용할 수 있
습니다. Windows Vista 와 함께 제공되는 HP Backup and Recovery Manager 는 제한된 버전입
니다. http://www.hp.com 에서 소프트웨어 & 드라이버 다운로드를 눌러 업데이트를 확인하십시
오.

사용이 편리한 HP Backup and Recovery Manager 는 시스템별로 미리 로드되는 다목적 응용프로그램
으로서 다음과 같은 기능을 지원합니다.

● 전체 시스템을 점증적으로 백업하는 복구 지점 생성

● 단일 하드 아카이브로 전체 시스템 백업

● 개별 파일 백업

백업은 예정된 간격에 따라 자동으로 실행되도록 예약하거나 수동으로 실행할 수도 있습니다. 복구는
하드 드라이브의 복구 파티션 또는 복구 디스크 세트로부터 수행할 수 있습니다. 복구 디스크 세트
에는 Restore Plus! CD, Microsoft 운영체제 및 기타 보조 소프트웨어 CD 가 포함됩니다.

HP 는 컴퓨터를 사용하기 전에 복구 디스크 세트를 즉시 만들고 정기적인 자동 복구 지점 백업을 예약
하도록 권장합니다.

복구 디스크 세트를 생성하려면 다음과 같이 하십시오.

1. 시작 > HP Backup and Recovery > HP Backup and Recovery Manager 를 눌러 Backup and
Recovery Wizard(백업 및 복구 마법사)를 열고 Next(다음)를 누릅니다.

2. Create factory software recovery CDs or DVDs to recover the system(출하 시 소프트웨어
복구 CD 또는 DVD 를 만들어 시스템 복구)을 선택합니다.

3. 마법사의 지침에 따릅니다.

HP Backup and Recovery Manager 에는 두 가지 기본 복구 방법이 있습니다. 첫 번째인 파일 및 폴더
복구는 Windows 에서 작동합니다. 두 번째인 PC 복구에서는 복구 파티션으로 재부팅하거나 복구 디
스크 세트로부터 재부팅해야 합니다. 복구 파티션으로 재부팅하려면 시작 시 Press F11 for
Emergency Recovery(응급 복구를 위해서는 F11 을 누르십시오) 메시지가 표시될 때 F11 을 누릅니
다.

HP Backup and Recovery Manager 를 사용하는 방법에 대한 자세한 내용은 시작 > HP Backup and
Recovery > HP Backup and Recovery Manager Manual 을 선택하여 표시되는 HP Backup and
Recovery Manager User Guide 를 참조하십시오.

주: 복구 디스크 세트는 HP 지원 센터에 전화로 주문할 수 있습니다. 해당 지역의 지원 센터 전
화 번호는 다음 웹 사이트로 가서 Call HP(HP 연락처)라는 제목 아래 Technical support after
you buy(제품 사용 중 기술 지원 문의) 링크를 누르면 찾을 수 있습니다.

http://welcome.hp.com/country/us/en/wwcontact_us.html
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2 전문가의 진단 없이 문제를 해결하는 방법

이 장에서는 디스켓 드라이브, 하드 드라이브, 광 드라이브, 그래픽, 오디오, 메모리 및 소프트웨어 등
에서 발생하는 사소한 문제들을 식별하고 해결하는 방법에 관해 설명합니다. 컴퓨터에 문제가 발생하
면 이 장의 예상 원인 및 권장 조치에 대한 표를 참조하십시오.

주: POST(전원 켤 때 자체 테스트) 중 화면에 나타나는 특정 오류 메시지에 관한 자세한 내용
은 부록 A, 49페이지의 POST 오류 메시지를 참조하십시오.

안전 및 편의

경고! 컴퓨터를 잘못 사용하거나 안정적인 작업 환경을 조성하지 못하면 작업에 불편이 따르
거나 심각한 손상이 발생할 수 있습니다. 작업 영역 선택 및 안전하고 편리한 작업 환경을 만드
는 방법에 대한 자세한 내용은 웹 사이트 http://www.hp.com/ergo 에서 제공되는
Documentation and Diagnostics CD 의 안전 및 편의 설명서를 참조하십시오. 본 장비는 모든 검
사를 마쳤으며 FCC 규정 15 항에 근거한 클래스 B 디지털 장비 제한 사항을 준수합니다. 자세
한 내용은 Documentation and Diagnostics CD 의 안전 및 규정 정보를 참조하십시오.

기술 지원 센터에 문의하기 전에
컴퓨터에 문제가 있으면 기술 지원 센터에 문의하기 전에 정확한 문제를 식별할 수 있도록 아래의 적
절한 해결책을 시도해 보십시오.

● 진단 유틸리티를 실행합니다. 자세한 내용은 1 장, 1페이지의 컴퓨터 진단 기능을 참조하십시오.

● Computer Setup 의 DPS(드라이브 보호 시스템) 자가 진단 테스트를 실행합니다. 자세한 내
용은 Documentation and Diagnostics CD 의 Computer Setup(F10) 유틸리티 설명서를 참조하십
시오.

● 컴퓨터 앞면에 있는 전원 LED 가 빨간색으로 깜박이는지 확인하십시오. 깜박이는 빛이 오류 코드
로서 문제를 진단하는 데 도움을 줍니다. 자세한 내용은 부록 A, 49페이지의 POST 오류 메시지
를 참조하십시오.

● 화면에 아무 것도 표시되지 않는 경우, 가능하면 모니터를 컴퓨터의 다른 비디오 포트에 연결하
십시오. 아니면 정상적으로 작동하는 모니터로 바꿉니다.

● 네트워크에서 작업 중인 경우 다른 케이블을 사용해 다른 컴퓨터를 네트워크와 연결해 보십시
오. 네트워크 소켓이나 케이블에 문제가 있을 수도 있습니다.

● 최근에 새 하드웨어를 추가한 경우에는 해당 하드웨어를 제거한 다음 컴퓨터가 정상적으로 작동
하는지 확인하십시오.

● 최근에 새 소프트웨어를 설치한 경우에는 해당 소프트웨어를 제거한 다음 컴퓨터가 정상적으로
작동하는지 확인하십시오.
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● 컴퓨터를 안전 모드로 부팅하여 모든 드라이버를 로드하지 않은 채 부팅되는지 확인합니다. 운영
체제를 부팅할 때는 마지막으로 사용한 구성을 사용합니다.

● 전반적인 온라인 기술 지원은 http://www.hp.com/support 를 참조하십시오.

● 이 설명서의 8페이지의 유용한 참고 사항 섹션을 참조하십시오.

문제를 온라인으로 해결할 수 있도록 HP Instant Support Professional Edition 은 자가 진단 기능을 제
공합니다. HP 고객 지원 센터에 문의하려면 HP Instant Support Profession Edition 온라인 채팅 기능을
사용하십시오. HP Instant Support Professional Edition 주소: http://www.hp.com/go/ispe

최신 온라인 지원 정보, 소프트웨어 및 드라이버, 사전 통지 및 전 세계 HP 전문가와 사용자 커뮤니티
에 대한 정보는 http://www.hp.com/go/bizsupport 의 BSC(Business Support Center)를 참조하십시오.

기술 지원 센터에 문의할 때 다음과 같이 하면 더욱 빠르게 서비스 안내를 받을 수 있습니다.

● 문의할 때 컴퓨터를 직접 보면서 하십시오.

● 문의 전에 컴퓨터 일련 번호, 제품 ID 번호 및 모니터 일련 번호를 적어 두십시오.

● 서비스 기술자와 함께 문제를 해결해 가십시오.

● 최근 시스템에 추가한 모든 하드웨어를 제거하십시오.

● 최근 설치한 모든 소프트웨어를 제거하십시오.

● 복구 디스크 세트에서 시스템을 복원하거나 HP Backup and Recovery Manager 에서 시스템을 출
하 시 상태로 복원하십시오.

주의: 시스템을 복원하면 하드 드라이브의 모든 데이터가 지워집니다. 복원 프로세스를 실행
하기 전에 데이터 파일을 모두 백업하십시오.

주: 판매 정보 및 보증 업그레이드(Care Packs)에 대한 자세한 내용은 해당 지역의 공인 서비
스 제공업체 또는 판매업체에 문의하십시오.

유용한 참고 사항
컴퓨터, 모니터, 소프트웨어 등에 문제가 발생한 경우 다른 조치를 취하기 전에 먼저 다음의 일반적인
제안 목록을 참조하십시오.

● 컴퓨터와 모니터가 정상적인 전기 콘센트에 연결되어 있는지 확인합니다.

● 전압 선택 스위치가 해당 지역에 맞는 전압(115V 또는 230V)으로 설정되어 있는지 확인합니다
(일부 모델만 해당).

● 컴퓨터가 켜져 있고 녹색 전원 표시등에 불이 들어와 있는지 확인합니다.

● 모니터가 켜져 있고 녹색 모니터 표시등에 불이 들어와 있는지 확인합니다.

● 컴퓨터 앞면에 있는 전원 LED 가 빨간색으로 깜박이는지 확인합니다. 깜박이는 빛이 오류 코드로
서 문제를 진단하는 데 도움을 줍니다. 자세한 내용은 부록 A, 49페이지의 POST 오류 메시지를
참조하십시오.

● 모니터가 흐릿하면 모니터의 밝기 및 대비 컨트롤을 조정합니다.

● 키를 누른 채로 기다려봅니다. 시스템에서 신호음이 울리면 키보드가 제대로 작동하는 것입니다.
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● 모든 케이블이 꼭 맞게 제대로 연결되어 있는지 확인합니다.

● 키보드의 키를 누르거나 전원 버튼을 눌러 컴퓨터를 작동시킵니다. 시스템이 계속 일시 정지 모
드 상태에 있는 경우 전원 버튼을 4 초 이상 눌러 컴퓨터를 종료한 다음 전원 버튼을 다시 눌러 컴
퓨터를 다시 시작합니다. 시스템이 종료되지 않으면 전원 코드를 뽑고 몇 초 후에 다시 연결합니
다. Computer Setup 에 정전 시 자동 시작으로 설정되어 있으면 컴퓨터가 다시 시작됩니다. 다시
시작되지 않으면 전원 버튼을 눌러 컴퓨터를 시작합니다.

● 비 플러그 앤 플레이를 지원하지 않는 확장 보드나 기타 옵션을 설치한 후에는 컴퓨터를 재구성
합니다. 자세한 내용은 32페이지의 하드웨어 설치 문제 해결을 참조하십시오.

● 필요한 모든 장치 드라이버가 설치되어 있는지 확인하십시오. 예를 들어 프린터를 사용 중인 경
우 해당 프린터 모델용 드라이버가 필요합니다.

● 컴퓨터를 켜기 전에 시스템에서 모든 부팅 미디어(디스켓, CD 또는 USB 장치)를 제거합니다.

● 출하 시 설치된 운영체제 이외의 운영체제를 설치한 경우 시스템에서의 지원 여부를 확인합니
다.

● 컴퓨터에 내장, PCI 또는 PCI-Express 어댑터 등의 여러 비디오 소스가 설치되어 있고(특정 모델
전용 내장 비디오) 모니터는 한 대인 경우 기본 VGA 어댑터로 선택한 소스의 모니터 연결단자에
해당 모니터를 연결해야 합니다. 부팅 중에는 기타 모니터 연결단자가 비활성화되며 모니터가 이
포트에 연결된 경우 모니터는 작동하지 않습니다. Computer Setup 에서 기본 VGA 소스를 선택할
수 있습니다.

주의: 컴퓨터가 AC 전원에 연결되어 있는 경우 시스템 보드에 항상 전압이 흐르고 있습니다.
시스템 보드나 부품 손상을 방지하려면 컴퓨터를 열기 전에 먼저 전원 코드를 분리해야 합니
다.
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일반 문제 해결
이 단원에 설명된 일반적인 문제는 사용자가 쉽게 해결할 수 있습니다. 문제가 지속되어 사용자 스스
로 해결할 수 없거나 작업에 익숙하지 않을 경우 공인 판매업체나 대리점에 문의하십시오.

경고! 컴퓨터가 AC 전원에 연결되어 있는 경우 시스템 보드에 항상 전압이 흐르고 있습니다.
감전이나 뜨거운 표면으로 인한 부상의 위험이 있으므로 반드시 벽면 콘센트에서 전원 코드를
뽑고 내부 시스템 부품의 열이 식은 다음에 만지십시오.

DIMM 소켓 사이의 LED 를 확인합니다. LED 가 켜져 있으면 시스템에 여전히 전원이 들어와 있
는 것입니다. 컴퓨터를 끄고 전원 코드를 분리한 다음 작업을 진행하십시오.

표 2-1  일반 문제 해결

컴퓨터가 잠긴 것처럼 보이고 전원 버튼을 눌러도 전원이 꺼지지 않습니다.

원인 해결책

전원 스위치의 소프트웨어 컨트롤이 작동하지 않습니다. 1. 컴퓨터가 꺼질 때까지 약 4 초 동안 전원 버튼을 누릅니
다.

2. 전기 콘센트에서 전원 코드를 뽑습니다.

컴퓨터가 USB 키보드 또는 마우스에 응답하지 않습니다.

원인 해결책

컴퓨터가 대기모드에 있습니다. 대기 모드에서 다시 계속하려면 전원 버튼을 누르거나 아무 키
나 누릅니다.

주의: 대기 모드에서 다시 계속하는 경우 전원 버
튼을 4 초 이상 누르지 마십시오. 4 초 이상 누르면 컴
퓨터가 종료되어 저장되지 않은 데이터를 잃게 됩니
다.

시스템이 잠겨 있습니다. 컴퓨터를 다시 시작합니다.

컴퓨터의 날짜와 시간 표시가 올바르지 않습니다.

원인 해결책

RTC(실시간 시계) 배터리를 교체해야 합니다.

주: 컴퓨터를 가동 중인 AC 콘센트에 연결해 두면
RTC 배터리의 수명이 길어집니다.

먼저 제어판에서 날짜와 시간을 재설정합니다. Computer
Setup 을 사용하여 RTC 날짜와 시간을 업데이트할 수도 있습
니다. 문제가 지속되면 RTC 배터리를 교체합니다. 새 배터리
설치에 관한 자세한 방법은 Documentation and Diagnostics
CD 의 하드웨어 참조 설명서를 참조하고, RTC 배터리를 교체
하려면 공인 판매업체 또는 대리점에 문의하십시오.

키패드의 화살표 키로 커서를 움직일 수 없습니다.

원인 해결책

num lock 키가 켜져 있습니다. num lock 키를 누릅니다. 키패드에서 화살표 키를 사용하
려면 Num Lock 표시등이 꺼져 있어야 합니다. num lock
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키패드의 화살표 키로 커서를 움직일 수 없습니다.

원인 해결책

키는 Computer Setup 에서 비활성화(또는 활성화)할 수 있습
니다.

소리가 안 나거나 소리 볼륨이 너무 작습니다.

원인 해결책

시스템 볼륨이 낮거나 음소거로 설정되어 있습니다. 1. 내부 시스템 스피커가 음소거로 설정되어 있지 않은지 확
인하려면 F10 BIOS 설정을 확인하십시오. 외부 스피커에
는 영향을 주지 않습니다.

2. 외부 스피커가 올바르게 연결되어 있고 전원이 켜져 있는
지 확인하고 스피커 볼륨 컨트롤이 올바르게 설정되어 있
는지 확인합니다.

3. 스피커가 음소거로 설정되어 있지 않은지 확인하거나 볼
륨을 높이려면 운영체제에서 제공되는 시스템 볼륨 컨트
롤을 사용합니다.

컴퓨터 덮개나 액세스 패널을 분리할 수 없습니다.

원인 해결책

일부 컴퓨터에서 사용하는 Smart Cover Lock 이 잠겨 있습니
다.

Computer Setup 을 사용하여 Smart Cover Lock 의 잠금을 해
제하십시오.

Smart Cover Lock 기능을 수동으로 해제할 수 있는 장치인
Smart Cover FailSafe 키를 HP 를 통해 구입할 수 있습니다.
암호를 잊어버렸거나 정전 또는 컴퓨터 오작동 시 FailSafe 키
를 사용해야 합니다. 렌치형 키의 경우 PN 166527-001 을 주

문하거나 십자 드라이버 비트 키의 경우 PN 166527-002 를 주
문하십시오.

성능이 기대에 미치지 못합니다.

원인 해결책

프로세서가 뜨겁습니다. 1. 컴퓨터로의 공기 흐름이 차단되지 않았는지 확인합니
다. 컴퓨터의 공기 배출구 주변과 모니터 위로 공기가 충
분히 순환될 수 있도록 약 10.2cm 정도의 여유 공간을 두
십시오.

2. 팬이 제대로 연결되어 작동하는지 확인합니다. (일부 팬
은 필요 시에만 작동합니다.)

3. 프로세서 방열 장치가 제대로 설치되었는지 확인합니다.

하드 드라이브가 꽉 찼습니다. 하드 드라이브의 데이터를 다른 장치로 이동하여 하드 드라이
브의 공간을 늘립니다.

메모리가 부족합니다. 메모리를 추가합니다.

하드 드라이브가 조각나 있습니다. 하드 드라이브를 조각 모음합니다.

표 2-1  일반 문제 해결 (계속)
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성능이 기대에 미치지 못합니다.

원인 해결책

이전에 액세스한 프로그램에 사용된 메모리가 해제되지 않았
습니다.

컴퓨터를 다시 시작합니다.

하드 드라이브에 바이러스가 있습니다. 바이러스 백신 프로그램을 실행합니다.

너무 많은 응용프로그램이 실행 중입니다. 1. 사용하지 않는 응용프로그램을 닫고 메모리를 확보합니
다.

2. 메모리를 추가합니다. 일부 응용프로그램은 백그라운드
에서 실행되며 작업 트레이에서 해당 아이콘을 마우스 오
른쪽 버튼으로 눌러 닫을 수 있습니다. 시작 시 이 응용프
로그램이 시작되는 것을 방지하려면 시작 > 실행
(Windows XP)을 누르거나 시작 > 보조프로그램 > 실행
(Windows Vista)을 누른 후 msconfig 를 입력합니다. 시
스템 구성 유틸리티의 시작프로그램 탭에서 자동으로 시
작되지 않도록 할 응용프로그램의 확인란을 선택 해제합
니다.

일부 소프트웨어 응용프로그램(특히 게임)은 그래픽 하위 시
스템의 성능을 저하시킵니다.

1. 현재 응용프로그램의 해상도를 낮추거나 응용프로그램
과 함께 제공된 설명서에서 응용프로그램의 매개 변수를
조정하여 성능을 향상시키는 방법에 대한 제안을 참조합
니다.

2. 메모리를 추가합니다.

3. 그래픽 솔루션을 업그레이드합니다.

원인을 알 수 없습니다. 컴퓨터를 다시 시작합니다.

컴퓨터 전원이 자동으로 꺼지고 빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 2 번 깜박이고 컴퓨터 신호음이 2 번 울
립니다. (신호음은 5 번 반복되었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

다음과 같은 경우에 프로세서 과열 방지 기능이 작동됩니다.

팬이 걸려서 움직이지 않거나 돌아가지 않는 경우

또는

방열 장치가 프로세서에 제대로 장착되지 않은 경우

1. 컴퓨터 통풍구가 막히지 않고 프로세서 냉각 팬이 작동하
는지 확인합니다.

2. 덮개를 열고 전원 버튼을 누른 후 프로세서 팬이 돌아가
는지 확인합니다. 프로세서 팬이 돌지 않는 경우 팬 케이
블이 시스템 보드 헤더에 연결되어 있는지 확인합니다.

3. 팬이 꽂혀 있지만 돌고 있지 않으면 방열 장치/팬 어셈블
리를 교체하십시오.

4. 공인 판매업체 또는 서비스 제공업체에 문의합니다.

표 2-1  일반 문제 해결 (계속)
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시스템 전원이 켜지지 않고 컴퓨터 앞면의 표시등이 깜박이지 않습니다.

원인 해결책

시스템 전원을 켤 수 없습니다. 4 초보다 짧게 전원 버튼을 누릅니다. 하드 드라이브 표시등에
녹색 불이 켜지면 다음 작업을 수행하십시오.

1. 전원 선택 스위치(일부 모델에는 전원 공급 장치 뒷면에

있음)가 적정 전압으로 설정되어 있는지 확인합니다. 적
정 전압 설정은 해당 지역에 따라 다릅니다.

2. 시스템 보드의 5V_aux 표시등이 켜질 때까지 확장 카드
를 하나씩 분리합니다.

3. 시스템 보드를 교체합니다.

또는

4 초보다 짧게 전원 버튼을 누릅니다. 하드 드라이브 표시등에

녹색 불이 켜지지 않으면 다음 작업을 수행하십시오.

1. 전원 케이블이 정상적으로 작동하는 AC 콘센트에 꽂혀
있는지 확인합니다.

2. 덮개를 열고 전원 버튼 케이블이 시스템 보드에 제대로
연결되어 있는지 확인합니다.

3. 2 개의 전원 공급 장치 케이블이 모두 시스템 보드에 제
대로 연결되어 있는지 확인합니다.

4. 시스템 보드의 5V_aux 표시등이 켜져 있는지 확인합니
다. 켜져 있으면 전원 버튼 케이블을 교체합니다.

5. 시스템 보드의 5V_aux 표시등이 꺼져 있으면 전원 공급

장치를 교체합니다.

6. 시스템 보드를 교체합니다.

표 2-1  일반 문제 해결 (계속)
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전원 문제 해결
다음 표에 전원 문제의 일반적인 원인 및 해결 방법이 설명되어 있습니다.

표 2-2  전원 문제 해결

전원 공급 장치가 일시적으로 종료됩니다.

원인 해결책

컴퓨터 섀시 뒷면의 전원 선택 스위치가 적정한 전압(115V
또는 230V)으로 설정되어 있지 않습니다(일부 모델만 해당).

슬라이드 스위치를 적정한 AC 전압으로 조정합니다.

내부 전원 공급 장치의 결함 때문에 전원 공급 장치가 켜지지
않습니다.

전원 공급 장치를 교체하려면 공인 서비스 제공업체에 문의하
십시오.

컴퓨터 전원이 자동으로 꺼지고 빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 2 번 깜박이고 컴퓨터 신호음이 2 번 울
립니다. (신호음은 5 번 반복되었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

다음과 같은 경우에 프로세서 과열 방지 기능이 작동됩니다.

팬이 걸려서 움직이지 않거나 돌아가지 않는 경우

또는

방열 장치가 프로세서에 제대로 장착되지 않은 경우

1. 컴퓨터 통풍구가 막히지 않고 프로세서 냉각 팬이 작동하
는지 확인합니다.

2. 덮개를 열고 전원 버튼을 누른 후 프로세서 팬이 돌아가
는지 확인합니다. 프로세서 팬이 돌지 않는 경우 팬 케이
블이 시스템 보드 헤더에 연결되어 있는지 확인합니다.

3. 팬이 꽂혀 있지만 돌고 있지 않으면 방열 장치/팬 어셈블
리를 교체하십시오.

4. 공인 판매업체 또는 서비스 제공업체에 문의합니다.

빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 4 번 깜박이고 컴퓨터 신호음이 4 번 울립니다. (신호음은 5 번 반복되었
다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

전원 실패(전원 공급 장치 과부하) 1. 전원 공급 장치 뒷면의 전원 선택 스위치가 적정 전압으
로 설정되어 있는지 확인합니다(일부 모델만 해당). 적정
전압 설정은 해당 지역에 따라 다릅니다.

2. 덮개를 열고 4 선 또는 6 선 전원 공급 장치 케이블이 시
스템 보드의 연결단자에 연결되어 있는지 확인합니다.

3. 설치된 모든 장치(하드, 디스켓 또는 광 드라이브 및 확장

카드 등)를 제거하고 장치에 문제가 있는지 확인합니다.
시스템 전원을 켭니다. 시스템이 POST 로 진입한 다음
오류를 찾을 때까지 한 번에 하나씩 장치의 전원을 끄고
다시 설치하는 과정을 반복합니다. 문제의 원인이 되는
장치를 교체합니다. 한 번에 하나씩 장치를 계속 추가하
여 모든 장치가 제대로 작동하는지 확인합니다.

4. 전원 공급 장치를 교체합니다.

5. 시스템 보드를 교체합니다.
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디스켓 문제 해결
다음 표에 디스켓 문제의 일반적인 원인 및 해결 방법이 설명되어 있습니다.

주: 디스켓 드라이브 같은 하드웨어를 추가하거나 제거하는 경우 컴퓨터를 재구성해야 합니
다. 자세한 내용은 32페이지의 하드웨어 설치 문제 해결을 참조하십시오.

표 2-3  디스켓 문제 해결

디스켓 드라이브 표시등이 켜져 있습니다.

원인 해결책

디스켓이 손상되었습니다. Microsoft Windows XP 의 경우 마우스 오른쪽 버튼으로 시작
을 누르고 탐색을 누른 다음 드라이브를 선택합니다. 파일 >
속성 > 도구를 선택합니다. 오류 검사에서 지금 검사를 누릅니
다.

Microsoft Windows Vista 의 경우 마우스 오른쪽 버튼으로 시
작을 누르고 탐색을 누른 다음 마우스 오른쪽 버튼으로 드라이
브를 누릅니다. 속성을 선택한 후 도구 탭을 선택합니다. 오류
검사에서 지금 검사를 누릅니다.

디스켓을 잘못 삽입했습니다. 디스켓을 꺼내고 다시 삽입합니다.

드라이브 케이블이 제대로 연결되지 않았습니다. 드라이브 케이블을 다시 연결합니다. 디스켓 전원 케이블에
있는 4 개의 핀이 모두 드라이브에 연결되어 있는지 확인합니

다.

드라이브를 찾을 수 없습니다.

원인 해결책

케이블이 느슨합니다. 디스켓 드라이브 데이터 케이블과 전원 케이블을 다시 설치합
니다.

이동식 드라이브가 제대로 설치되지 않았습니다. 드라이브를 다시 설치합니다.

디스켓 드라이브가 디스켓에 쓰지 못합니다.

원인 해결책

디스켓이 포맷되지 않았습니다. 디스켓을 포맷합니다.

1. Windows 탐색기에서 디스크 (A) 드라이브를 선택합니
다.

2. 해당 드라이브 문자를 마우스 오른쪽 버튼으로 누르고 포
맷을 선택합니다.

3. 원하는 옵션을 선택한 다음 시작을 눌러 디스켓 포맷을
시작합니다.

디스켓에 쓰기가 금지되어 있습니다. 다른 디스켓을 사용하거나 쓰기 금지를 해제합니다.

다른 드라이브에 쓰기를 실행하고 있습니다. 경로의 드라이브 문자가 맞는지 확인합니다.

디스켓의 남아 있는 공간이 부족합니다. 1. 다른 디스켓을 사용합니다.

2. 디스켓에서 필요하지 않은 파일을 삭제합니다.
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디스켓 드라이브가 디스켓에 쓰지 못합니다.

원인 해결책

Computer Setup 에서 레거시 디스켓 쓰기가 비활성화되어 있
습니다.

Computer Setup 을 시작하고 Storage > Storage Options
에서 Legacy Diskette Write 를 활성화합니다.

디스켓이 손상되었습니다. 손상된 디스크를 교체합니다.

디스켓을 포맷할 수 없습니다.

원인 해결책

사용할 수 없는 미디어입니다. MS-DOS 에서 디스크를 포맷하려면 디스켓 용량을 지정해야

합니다. 예를 들어 1.44MB 디스켓을 포맷하려면 MS-DOS 프
롬프트에 다음 명령을 입력합니다.

FORMAT A: /F:1440

디스크 쓰기가 금지되어 있습니다. 디스켓의 잠금 장치를 엽니다.

Computer Setup 에서 레거시 디스켓 쓰기가 비활성화되어 있
습니다.

Computer Setup 을 시작하고 Storage > Storage Options
에서 Legacy Diskette Write 를 활성화합니다.

디스크 처리에 문제가 발생하였습니다.

원인 해결책

디렉토리 구성에 오류가 있거나 파일에 문제가 있습니다. Microsoft Windows XP 의 경우 마우스 오른쪽 버튼으로 시작

을 누르고 탐색을 누른 다음 드라이브를 선택합니다. 파일 >
속성 > 도구를 선택합니다. 오류 검사에서 지금 검사를 누릅니
다.

Microsoft Windows Vista 의 경우 마우스 오른쪽 버튼으로 시
작을 누르고 탐색을 누른 다음 마우스 오른쪽 버튼으로 드라이
브를 누릅니다. 속성을 선택한 후 도구 탭을 선택합니다. 오류
검사에서 지금 검사를 누릅니다.

디스켓 드라이브가 디스켓을 읽지 못합니다.

원인 해결책

드라이브 종류에 맞지 않는 디스켓을 사용하고 있습니다. 사용하는 드라이브 종류를 확인하고 올바른 디스켓을 사용하
십시오.

다른 드라이브를 읽고 있습니다. 경로의 드라이브 문자가 맞는지 확인합니다.

디스켓이 손상되었습니다. 새 디스켓으로 교체합니다.

표 2-3  디스켓 문제 해결 (계속)
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"사용할 수 없는 디스크"라는 메시지가 표시됩니다.

원인 해결책

드라이브에 컴퓨터를 시동하는 데 필요한 시스템 파일이 없는
디스켓을 삽입하였습니다.

드라이브 작동이 멈추면 디스켓을 꺼내고 스페이스바를 누릅
니다. 컴퓨터가 시작됩니다.

디스켓 오류가 발생했습니다. 전원 버튼을 눌러 컴퓨터를 다시 시작합니다.

디스켓으로 부팅할 수 없습니다.

원인 해결책

부팅 디스켓이 아닙니다. 부팅 디스켓으로 교체합니다.

디스켓 부팅이 Computer Setup 에서 비활성화되어 있습니다. 1. Computer Setup 을 실행하고 Storage > Boot Order 에
서 디스켓 부팅을 활성화합니다.

2. Computer Setup 을 실행하고 Storage > Storage
Options > Removable Media Boot 에서 디스켓 부팅을
활성화합니다.

주: Computer Setup 의 Removable Media Boot 기
능이 Boot Order 활성화 명령보다 우선 적용되는 경
우 두 단계를 모두 사용해야 합니다.

Computer Setup 에서 Network Server Mode 가 활성화되어 있
습니다.

Computer Setup 을 실행하고 Security > Password Options
에서 Network Server Mode 를 비활성화합니다.

Computer Setup 에서 이동식 미디어 드라이브 부팅이 비활성
화되었습니다.

Computer Setup 을 실행하고 Storage > Storage Options >
Removable Media Boot 에서 Removable Media Boot 를 활성
화합니다.

표 2-3  디스켓 문제 해결 (계속)
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하드 드라이브 문제 해결
표 2-4  하드 드라이브 문제 해결

하드 드라이브 오류 발생

원인 해결책

하드 디스크에 불량 섹터가 있거나 작동하지 않습니다. 1. Microsoft Windows XP 의 경우 마우스 오른쪽 버튼
으로 시작을 누르고 탐색을 누른 다음 드라이브를 선택합
니다. 파일 > 속성 > 도구를 선택합니다. 오류 검사에서
지금 검사를 누릅니다.

Microsoft Windows Vista 의 경우 마우스 오른쪽 버튼

으로 시작을 누르고 탐색을 누른 다음 마우스 오른쪽 버
튼으로 드라이브를 누릅니다. 속성을 선택한 후 도구 탭
을 선택합니다. 오류 검사에서 지금 검사를 누릅니다.

2. 유틸리티로 불량 섹터를 찾아 사용되지 않도록 차단합니
다. 필요하면 하드 디스크를 다시 포맷합니다.

디스크 트랜잭션 문제

원인 해결책

디렉토리 구조에 오류가 있거나 파일에 문제가 있습니다. Microsoft Windows XP 의 경우 마우스 오른쪽 버튼으로 시작
을 누르고 탐색을 누른 다음 드라이브를 선택합니다. 파일 >
속성 > 도구를 선택합니다. 오류 검사에서 지금 검사를 누릅니
다.

Microsoft Windows Vista 의 경우 마우스 오른쪽 버튼으로 시

작을 누르고 탐색을 누른 다음 마우스 오른쪽 버튼으로 드라이
브를 누릅니다. 속성을 선택한 후 도구 탭을 선택합니다. 오류

검사에서 지금 검사를 누릅니다.

드라이브를 찾을 수 없습니다(식별할 수 없음).

원인 해결책

케이블이 느슨합니다. 케이블 연결 상태를 확인합니다.

시스템이 새로 설치한 장치를 자동으로 인식하지 못했습니
다.

32페이지의 하드웨어 설치 문제 해결 섹션의 구성 지침을 참
조하십시오. 시스템이 여전히 새 장치를 인식하지 못하는 경
우, 그 장치가 Computer Setup 목록에 있는지 확인합니다. 목
록에 있으면 드라이버 문제이지만, 목록에 없으면 하드웨어 문
제입니다.

새로 설치한 드라이브의 경우 Computer Setup 유틸리티를 실

행하여 Advanced > Power-On 에 POST Delay 를 추가해 보
십시오.

장치가 Computer Setup 에서 해제된 SATA 포트에 연결되어
있습니다.

Computer Setup 유틸리티를 실행하고 장치의 SATA 포트가
Storage > Storage Options 에 설정되어 있는지 확인합니다.

시스템을 켠 직후 드라이브 응답 속도가 느립니다. Computer Setup 을 실행하여 Advanced > Power-On
Options 에 POST Delay 를 추가해 보십시오.
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비시스템 디스크/NTLDR 누락 메시지

원인 해결책

부팅할 수 없는 디스켓으로 시스템에서 시작을 시도하고 있습
니다.

디스켓 드라이브에서 디스켓을 꺼냅니다.

시스템이 시작하려는 하드 드라이브가 손상되었을 수 있습니
다.

1. 부팅 디스켓을 디스켓 드라이브에 삽입하고 컴퓨터를 다
시 시작합니다.

2. Fdisk 를 사용하는 하드 드라이브 포맷을 선택합니다.
NTFS 포맷의 경우 타사 리더를 사용하여 드라이브를 평
가합니다. FAT32 포맷인 경우 하드 드라이브에 액세스할
수 없습니다.

시스템 파일이 없거나 제대로 설치되지 않았습니다. 1. 부팅 디스켓을 디스켓 드라이브에 삽입하고 컴퓨터를 다
시 시작합니다.

2. Fdisk 를 사용하는 하드 드라이브 포맷을 선택합니다.
NFTFS 포맷의 경우 타사 리더를 사용하여 드라이브를

평가합니다. FAT32 포맷인 경우 하드 드라이브에 액세스
할 수 없습니다.

3. 해당 운영체제용 시스템 파일을 설치합니다.

Computer Setup 에서 하드 드라이브 부팅이 비활성화되었습
니다.

Computer Setup 유틸리티를 실행하고 Storage > Boot
Order 목록에서 해당 하드 드라이브 항목을 활성화합니다.

부팅할 수 있는 하드 드라이브가 멀티 하드 드라이브 구성에
서 주 드라이브로 연결되어 있지 않습니다.

하드 드라이브에서 부팅하려는 경우 하드 드라이브가 P60
SATA 0 이라는 레이블이 부착된 시스템 보드 연결단자에 연

결되어 있는지 확인합니다.

부팅 가능한 하드 드라이브의 컨트롤러가 Boot Order 에 1 순
위로 나열되어 있지 않습니다.

Computer Setup 유틸리티를 실행하고 Storage > Boot Order
를 선택한 다음 부팅 가능한 하드 드라이브의 컨트롤러가
Hard Drive 항목에 바로 나열되는지 확인합니다.

컴퓨터가 하드 드라이브로부터 부팅되지 않습니다.

원인 해결책

장치가 Computer Setup 에서 해제된 SATA 포트에 연결되어
있습니다.

Computer Setup 유틸리티를 실행하고 장치의 SATA 포트가
Storage > Storage Options 에 설정되어 있는지 확인합니다.

부팅 순서가 잘못되어 있습니다. Computer Setup 유틸리티를 실행하고 Storage > Boot Order
에서 부팅 순서를 변경합니다.

하드 드라이브의 "에뮬레이션 유형"이 "없음"으로 설정되어 있
습니다.

Computer Setup 유틸리티를 실행하고 Storage > Device
Configuration 의 장치 세부 정보에서 "에뮬레이션 유형"을
"하드 디스크"로 변경합니다.

장치가 Computer Setup 에서 해제된 SATA 포트에 연결되어
있습니다.

Computer Setup 유틸리티를 실행하고 장치의 SATA 포트가
Storage > Storage Options 에 설정되어 있는지 확인합니다.

하드 드라이브가 손상되었습니다. 앞면 패널 전원 LED 가 빨간색으로 깜박이는지, 신호음이 발
생하는지 확인합니다. 빨간색으로 깜박이는 것과 신호음이 발

생하는 원인을 확인하려면 부록 A, 49페이지의 POST 오류
메시지를 참조하십시오.

전 세계 공통 제한 보증의 조항과 조건을 확인하십시오.

표 2-4  하드 드라이브 문제 해결 (계속)
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컴퓨터가 잠겨 있는 것 같습니다.

원인 해결책

사용 중인 프로그램이 명령에 응답하지 않습니다. 정상적인 Windows 종료 절차를 시도해 봅니다. 컴퓨터가 종
료되지 않으면 전원 버튼을 4 초 이상 눌러 전원을 끕니다. 컴
퓨터를 다시 시작하려면 전원 버튼을 다시 누릅니다.

이동식 하드 드라이브의 하드 드라이브 인클로저에 전원이 공급되지 않는다고 표시됩니다.

원인 해결책

인클로저의 잠금 장치가 “ON” 위치에 놓여있지 않습니다. 키를 입력한 후 잠금 장치를 시계 방향으로 90 도 회전합니
다. 인클로저 앞면의 녹색 LED 에 불빛이 들어와야 합니다.

컴퓨터 전원 공급 장치와 인클로저 프레임에 전원 케이블이 제
대로 연결되지 않았습니다.

전원 공급 장치가 인클로저 프레임 뒷면에 제대로 연결되어 있
는지 확인합니다.

컴퓨터가 이동식 하드 드라이브를 인식하지 못합니다.

원인 해결책

이동식 하드 드라이브 캐리어가 인클로저 프레임에 제대로 장
착되지 않았거나 하드 드라이브가 캐리어에 제대로 설치되지
않았습니다.

캐리어를 인클로저 프레임에 밀어 넣어 프레임 뒷면의 연결단
자를 제대로 장착합니다. 그래도 문제가 해결되지 않으면 컴

퓨터를 끄고 캐리어를 분리한 후 하드 드라이브의 연결단자가
캐리어에 제대로 장착되어 있는지 확인합니다.

이동식 하드 드라이브 인클로저에서 신호음이 울리고 녹색 LED 가 깜박입니다.

원인 해결책

이동식 하드 드라이브 인클로저의 팬 오류 경보가 작동되었습
니다.

컴퓨터를 종료한 후 HP 에 문의하여 인클로저를 교체합니다.

표 2-4  하드 드라이브 문제 해결 (계속)
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미디어 카드 리더 문제 해결
표 2-5  미디어 카드 리더 문제 해결

미디어 카드를 Microsoft Windows XP 또는 Microsoft Windows Vista 에서 포맷하면 이후에 디지털 카메라에서 카드가 작동
하지 않습니다.

원인 해결책

기본적으로 Windows XP 및 Windows Vista 에서는 용량이
32MB 이상인 미디어 카드를 FAT32 로 포맷합니다. 대부분의
디지털 카메라에서는 FAT(FAT16 및 FAT12) 포맷을 사용
하며 FAT32 로 포맷된 카드는 사용할 수 없습니다.

미디어 카드를 디지털 카메라에서 포맷하거나 Windows XP
또는 Windows Vista 컴퓨터에서 미디어 카드를 포맷할 때
FAT 파일 시스템을 선택합니다.

미디어 카드에 데이터를 기록할 때 쓰기 금지 또는 잠김 오류가 발생합니다.

원인 해결책

미디어 카드가 잠겨 있습니다. 미디어 카드 잠금은 SD/
Memory Stick/PRO 카드 등에서 데이터를 기록하거나 삭제하
지 못하도록 방지하는 보안 기능입니다.

SD 카드를 사용하는 경우 SD 카드 오른쪽에 있는 잠금 탭이
잠금 위치에 있지 않은지 확인합니다. Memory Stick/PRO 카
드를 사용하는 경우 Memory Stick/PRO 카드 아래에 있는 잠

금 탭이 잠금 위치에 있지 않은지 확인합니다.

미디어 카드에 기록할 수 없습니다.

원인 해결책

미디어 카드가 ROM(읽기 전용 메모리) 카드입니다. 카드가 쓰기 가능한지 확인하려면 카드에 포함된 해당 제조업
체의 설명서를 확인하십시오. 호환 가능한 카드 목록은 이전
단원을 참조하십시오.

미디어 카드를 슬롯에 넣은 후 데이터에 액세스할 수 없습니다.

원인 해결책

미디어 카드가 제대로 삽입되지 않았거나, 잘못된 슬롯에 삽

입되었거나, 지원되지 않는 카드입니다.
금색 접촉면을 올바른 방향으로 하여 카드를 제대로 삽입했는
지 확인합니다. 카드를 제대로 삽입하면 녹색 LED 가 켜집니
다.

미디어 카드를 올바르게 분리하는 방법을 모릅니다.

원인 해결책

컴퓨터의 소프트웨어를 사용하면 카드를 안전하게 꺼낼 수 있
습니다.

내 컴퓨터(Windows XP) 또는 컴퓨터(Windows Vista)를 열고
해당 드라이브 아이콘을 마우스 오른쪽 버튼으로 누른 후 꺼
내기를 선택합니다. 그런 다음 슬롯에서 카드를 잡아 당깁니

다.

주: 녹색 LED 가 깜박이는 동안에는 카드를 꺼내지

마십시오.
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미디어 카드 리더를 설치하고 Windows 에 부팅한 후 리더 및 삽입된 카드를 컴퓨터에서 인식하지 못합니다.

원인 해결책

리더를 컴퓨터에 설치하고 PC 를 처음 켤 때는 운영체제에서
장치를 인식하는 데 시간이 걸립니다.

운영체제에서 리더 및 사용 가능한 포트를 인식할 때까지 몇
초 정도 기다리면 리더에 삽입된 미디어도 인식됩니다.

리더에 미디어 카드를 삽입한 후 컴퓨터가 미디어 카드로부터 부팅을 시도합니다.

원인 해결책

삽입한 미디어 카드에 부팅 기능이 있습니다. 미디어 카드로부터 부팅 기능을 사용하지 않으려면 부팅 중 카
드를 분리하거나 부팅 프로세스 중에 삽입된 미디어 카드로부
터의 부팅 옵션을 선택하지 마십시오.

미디어 카드 리더의 USB 포트에 삽입된 이동식 USB 드라이브 또는 미디어로부터 컴퓨터가 부팅되지 않습니다.

원인 해결책

미디어 카드 리더가 HP 데스크탑 BIOS 에서 지원되지 않는 방
식인 PCI 카드를 통해 컴퓨터에 연결되어 있습니다.

미디어 카드 리더를 컴퓨터 시스템 보드의 USB 연결단자에 연
결하면 부팅 가능한 USB 장치에서 부팅 기능을 지원합니다.
사용 가능한 연결단자가 없으면 컴퓨터의 다른 USB 포트에 부
팅 가능한 장치를 꽂으십시오.

미디어 카드 리더를 설치한 후 컴퓨터 앞면의 USB 포트가 작동하지 않습니다.

원인 해결책

시스템 보드 연결단자를 리더에 사용할 수 있도록 앞면 USB
포트의 USB 케이블을 뽑았습니다.

앞면 USB 포트의 케이블을 다시 연결하십시오. PCI 카드를 설
치하고 미디어 리더를 PCI 카드의 USB 연결단자에 연결하십
시오.

표 2-5  미디어 카드 리더 문제 해결 (계속)
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디스플레이 문제 해결
디스플레이 문제가 발생하면 모니터와 함께 제공된 설명서 및 다음 표에 있는 일반적인 원인 및 해결
방법을 참조하십시오.

표 2-6  디스플레이 문제 해결

화면에 아무 것도 나타나지 않습니다(영상이 나타나지 않음).

원인 해결책

모니터가 켜져 있지 않고 모니터 표시등에 불이 들어와 있지
않습니다.

모니터를 켜고 모니터 표시등이 켜지는지 확인합니다.

모니터가 불량입니다. 다른 모니터를 사용합니다.

케이블이 잘못 연결되어 있습니다. 모니터 케이블이 컴퓨터와 전기 콘센트에 제대로 연결되어 있
는지 확인합니다.

화면 종료 유틸리티를 설치하였거나 절전 기능이 설정되어 있
습니다.

키보드에서 아무 키를 누르거나 마우스 버튼을 누른 후 암호
가 설정되어 있으면 암호를 입력합니다.

시스템 ROM 이 손상되었습니다. 시스템이 Boot Block
Emergency Recovery Mode(부트 블록 응급 복구 모드)에서 실
행되고 있습니다(8 번의 신호음이 울림).

최신 BIOS 이미지로 시스템 ROM 을 갱신합니다. 자세한 내

용은 Documentation and Diagnostics CD 의 데스크탑 관리 설
명서에서 "부트 블록 응급 복구 모드" 단원을 참조하십시오.

고정 동기화 모니터를 사용하고 있으며, 선택한 해상도에서 모
니터가 동기화되지 않습니다.

선택한 해상도와 동일한 수평 주사율을 모니터에 적용할 수 있
는지 확인합니다.

컴퓨터가 대기 모드에 있습니다. 대기 모드에서 다시 계속하려면 전원 버튼을 누릅니다.

주의: 대기 모드에서 다시 계속하는 경우 전원 버
튼을 4 초 이상 누르지 마십시오. 4 초 이상 누르면 컴

퓨터가 종료되어 저장되지 않은 데이터를 잃게 됩니
다.

모니터 케이블이 잘못된 연결단자에 연결되었습니다. 컴퓨터 시스템에 통합 그래픽 연결단자와 추가 그래픽 카드 연
결단자가 모두 있는 경우, 모니터 케이블을 컴퓨터 뒷면의 그
래픽 카드 연결단자에 꽂습니다.

컴퓨터 모니터 설정이 해당 모니터와 호환되지 않습니다. 1. Windows XP 제어판에서 디스플레이 아이콘을 두 번 누
른 후 설정 탭을 선택합니다.

Windows Vista 제어판의 모양 및 개인 설정에서 화면 해
상도 조정을 선택합니다.

2. 슬라이더 컨트롤을 사용하여 해상도를 재설정합니다.

PCI Express 그래픽 카드를 설치한 후 통합 그래픽을 활성화할 수 없습니다.

원인 해결책

Intel 통합 그래픽이 있는 시스템의 경우 PCI Express 그래픽

카드를 설치한 후에는 통합 그래픽을 활성화할 수 없습니다.
통합 그래픽은 표준 PCI 그래픽 카드를 설치한 경우

Computer Setup 에서 활성화할 수 있습니다.
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빈 화면이 나타나고 빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 5 번 깜박이고 컴퓨터 신호음이 5 번 울립니다. (신호
음은 5 번 반복되었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

사전 비디오 메모리 오류 1. DIMM 을 다시 장착합니다. 시스템 전원을 켭니다.

2. 한 번에 하나씩 DIMM 을 교체하여 문제가 있는 모듈을

찾아 냅니다.

3. 타사의 메모리를 HP 메모리로 교체합니다.

4. 시스템 보드를 교체합니다.

빈 화면이 나타나고 빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 6 번 깜박이고 컴퓨터 신호음이 6 번 울립니다. (신호
음은 5 번 반복되었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

사전 비디오 그래픽 오류 그래픽 카드가 설치된 시스템의 경우

1. 그래픽 카드를 다시 장착합니다. 시스템 전원을 켭니다.

2. 그래픽 카드를 교체합니다.

3. 시스템 보드를 교체합니다.

통합 그래픽 카드가 내장된 시스템의 경우 시스템 보드를 교
체합니다.

빈 화면이 나타나고 빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 7 번 깜박이고 컴퓨터 신호음이 7 번 울립니다. (신호
음은 5 번 반복되었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

시스템 보드 오류(비디오보다 ROM 에서 먼저 오류가 감지됨) 시스템 보드를 교체합니다.

절전 기능을 사용할 때 모니터가 제대로 작동하지 않습니다.

원인 해결책

절전 기능이 없는 모니터를 절전 기능이 활성화되어 있는 상
태에서 사용하고 있습니다.

모니터 절전 기능을 비활성화합니다.

선명하지 않은 글자

원인 해결책

밝기 및 대비 컨트롤이 제대로 설정되지 않았습니다. 모니터 밝기 및 대비 컨트롤을 조정합니다.

케이블이 제대로 연결되어 있지 않습니다. 그래픽 케이블이 그래픽 카드 및 모니터에 제대로 연결되었는
지 확인합니다.

표 2-6  디스플레이 문제 해결 (계속)
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화면이 흐리거나 일부 해상도로 설정할 수 없습니다.

원인 해결책

그래픽 컨트롤러가 업그레이드된 경우 적합한 그래픽 드라이
버가 로드되지 않았을 수 있습니다.

업그레이드 키트가 포함된 비디오 드라이버를 설치합니다.

모니터가 특정 해상도를 디스플레이할 수 없습니다. 해상도를 변경합니다.

그래픽 카드가 불량입니다. 그래픽 카드를 교체합니다.

화면이 일그러지거나 회전하거나 흔들리거나 번쩍거립니다.

원인 해결책

모니터 연결 상태가 불완전하거나 모니터 조정이 잘못되었습
니다.

1. 모니터 케이블이 컴퓨터에 제대로 연결되었는지 확인합
니다.

2. 이중 모니터 시스템이거나 다른 모니터가 가까이 있는 경
우, 전자기장의 간섭을 받지 않도록 서로 멀리 떨어진 위
치에 배치합니다.

3. 형광등 또는 선풍기가 모니터에 너무 가까이 있습니다.

모니터가 전자기장에 영향을 받지 않도록 해야 합니다. 모니터를 전자기장에 영향을 받지 않게 하십시오. 자세한 내

용은 컴퓨터와 함께 제공된 설명서를 참조하십시오.

이미지가 중앙에 나타나지 않습니다.

원인 해결책

위치를 조절해야 합니다. Menu(메뉴) 버튼을 눌러 OSD 메뉴에 액세스합니다.
ImageControl(이미지 제어)/ Horizontal Position(수평 위치)
또는 Vertical Position(수직 위치)을 선택하여 이미지의 수직
또는 수평 위치를 조절합니다.

"No Connection, Check Signal Cable(연결되지 않았습니다. 신호 케이블을 확인하십시오.)" 메시지가 화면에 표시됩니다.

원인 해결책

모니터 비디오 케이블이 연결되지 않았습니다. 모니터와 컴퓨터 사이에 비디오 케이블을 연결합니다.

주의: 비디오 케이블을 연결하는 동안 컴퓨터의 전
원이 꺼져 있는지 확인합니다.

화면에 "Out of Range(수신 범위를 벗어났습니다.)"가 표시됩니다.

원인 해결책

비디오 해상도 및 재생율이 모니터가 지원하는 것보다 높게 설
정되어 있습니다.

컴퓨터를 다시 시작하여 안전 모드로 들어갑니다. 지원되는 설
정으로 설정을 변경한 다음 새 설정이 적용되도록 컴퓨터를 다
시 시작합니다.

표 2-6  디스플레이 문제 해결 (계속)
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전원을 켤 때 CRT 모니터 내부에서 진동음이나 이상한 소리가 들립니다.

원인 해결책

모니터 전자기장 방지 코일이 작동되었습니다. 없음. 모니터를 켤 때 대개 전자기장 방지 코일이 작동됩니다.

CRT 모니터 내부에서 소음이 들립니다.

원인 해결책

전자 계전기가 모니터 내부에서 작동하고 있습니다. 없음. 대개 모니터를 켜고 끌 때, 대기 모드에서 나오거나 들어
갈 때 그리고 해상도를 변경할 때 소음이 들립니다.

평면 모니터 내부에서 고음이 들립니다.

원인 해결책

밝기 및 대비가 너무 높게 설정되었습니다. 밝기 및 대비 설정을 낮춥니다.

흐릿한 초점, 줄무늬, 잔상, 음영 효과, 가로 줄, 희미한 세로 줄 또는 화면 중앙에 그림이 오지 않습니다(아날로그 VGA 입력 연
결 전용 평면 모니터).

원인 해결책

평면 모니터의 내부 디지털 변환 회로가 그래픽 카드의 출력
동기화를 제대로 해독하지 못하는 경우가 있습니다.

1. 모니터의 화면 디스플레이 메뉴에서 자동 조정 옵션을 선
택합니다.

2. 화면 디스플레이 메뉴에서 Clock 및 Clock Phase 기능을
수동으로 동기화합니다. 동기화를 지원하는 SoftPaq 을
다운로드하려면 웹 사이트(www.hp.com/support)로 이동
하여 해당 모니터를 선택하고 SP32347 또는 SP32202
중 하나를 선택합니다. http://www.hp.com/support

그래픽 카드가 제대로 장착되지 않았거나 불량입니다. 1. 그래픽 카드를 다시 장착합니다.

2. 그래픽 카드를 교체합니다.

특정 형식의 기호가 제대로 나타나지 않습니다.

원인 해결책

사용하는 글꼴이 특정 기호를 지원하지 않습니다. 문자표를 사용하여 해당 기호를 찾아 선택합니다. 시작 > 프로
그램 > 보조 프로그램 > 시스템 도구 > 문자표를 누릅니다. 문
자표에서 문서로 기호를 복사할 수 있습니다.

표 2-6  디스플레이 문제 해결 (계속)
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오디오 문제 해결
컴퓨터에 오디오 기능이 있고 오디오 문제가 발생한 경우, 다음 표에 나오는 일반적인 원인 및 해결 방
법을 참조하십시오.

표 2-7  오디오 문제 해결

소리가 끊깁니다.

원인 해결책

다른 실행 중인 응용프로그램이 프로세서 리소스를 사용하고
있습니다.

프로세서를 사용하는 모든 실행 중인 응용프로그램을 종료합
니다.

여러 미디어 플레이어 응용프로그램에서 일반적으로 나타
나는 Direct Sound 대기 시간입니다.

Windows XP 에서만 가능합니다.

1. 제어판에서 사운드 및 오디오 장치를 선택합니다.

2. 오디오 탭에서 소리 재생 목록에 있는 장치를 선택합니
다.

3. 고급 버튼을 누르고 성능 탭을 선택합니다.

4. 하드웨어 가속 슬라이더는 없음으로, 샘플 속도 변환 품
질 슬라이더는 양호로 설정한 다음 오디오를 다시 테스트
합니다.

5. 하드웨어 가속 슬라이더는 최대로, 샘플 속도 변환 품질

슬라이더는 최상으로 설정한 다음 오디오를 다시 테스트
합니다.

스피커 또는 헤드폰에서 소리가 나지 않습니다.

원인 해결책

소프트웨어 볼륨 컨트롤을 줄였거나 음소거한 상태입니다. 도구 모음의 스피커 아이콘을 두 번 누른 다음 음소거가 선택
되지 않았는지 확인하고 볼륨 슬라이더를 사용하여 볼륨을 조
정합니다.

Computer Setup 에서 오디오가 숨겨져 있습니다. Computer Setup 에서 오디오를 활성화하려면 Security >
Device Security > Audio 를 차례로 누릅니다.

외부 스피커가 켜지지 않습니다. 외부 스피커를 켭니다.

오디오 장치가 컴퓨터 뒷면의 잘못된 잭에 연결되어 있거나 해
당 잭이 다른 기능을 수행하도록 재지정되어 있습니다.

장치가 컴퓨터 뒷면의 올바른 잭에 연결되어 있는지 확인합니
다. 올바른 잭에 연결되어 있는데도 문제가 지속되면 해당 잭

이 기본 기능이 아닌 다른 기능을 수행하도록 재지정되어 있
을 수 있습니다. 작업 트레이에서 Realtek HD Audio
Manager 아이콘을 누르거나 해당 운영체제의 제어판에서
Realtek 항목을 눌러 Realtek 제어판을 열고 잭에 원하는 기능
을 설정합니다.

외부 스피커를 최근 설치한 사운드 카드의 잘못된 오디오 잭
에 꽂았습니다.

사운드 카드 설명서를 참조하여 스피커를 올바로 연결합니
다.

디지털 CD 가 활성화되지 않았습니다. 디지털 CD 오디오를 활성화합니다. 장치 관리자에서 마우스
오른쪽 버튼으로 CD/DVD 장치를 누르고 등록 정보를 선택합
니다. Enable digital CD audio for this CD-ROM device(이
CD-ROM 에 해당하는 디지털 CD 오디오 활성화)를 선택합니
다.
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스피커 또는 헤드폰에서 소리가 나지 않습니다.

원인 해결책

라인 출력 연결단자에 연결된 헤드폰 또는 장치는 내부 스피
커에서 소리가 나지 않게 합니다.

연결이 되어 있는 경우 헤드폰 또는 외부 스피커를 켜고 사용
하거나 연결을 해제합니다.

컴퓨터가 대기 모드에 있습니다. 대기 모드에서 다시 계속하려면 전원 버튼을 누릅니다.

주의: 대기 모드에서 다시 계속하는 경우 전원 버
튼을 4 초 이상 누르지 마십시오. 4 초 이상 누르면 컴
퓨터가 종료되어 저장되지 않은 데이터를 잃게 됩니
다.

헤드폰의 소리가 맑지 않거나 들리지 않습니다.

원인 해결책

헤드폰이 뒷면 오디오 출력 연결단자에 연결되어 있습니다. 뒷
면 오디오 출력 연결단자는 전원을 사용하는 오디오 장치용이
고 헤드폰용으로 설계되지 않았습니다.

컴퓨터 앞면의 헤드폰 연결단자에 헤드폰을 연결합니다.

오디오를 기록하는 동안 컴퓨터가 잠겨 있습니다.

원인 해결책

하드 디스크가 꽉 찼습니다. 기록하기 전에 하드 디스크에 여유 공간이 충분한지 확인합니
다. 오디오 파일을 압축 포맷으로 기록할 수도 있습니다.

입력 라인, 출력 라인, 헤드폰 또는 마이크 잭이 제대로 작동하지 않습니다.

원인 해결책

오디오 드라이버 또는 응용프로그램 소프트웨어에서 잭이 다
시 구성되었습니다.

오디오 드라이버 또는 응용프로그램 소프트웨어에서 잭을 다
시 구성하거나 잭을 기본값으로 설정합니다.

표 2-7  오디오 문제 해결 (계속)

28 2 장   전문가의 진단 없이 문제를 해결하는 방법 KOWW



프린터 문제 해결
프린터 문제가 발생하면 프린터와 함께 제공된 설명서 및 다음 표에 있는 일반적인 원인 및 해결 방법
을 참조하십시오.

표 2-8  프린터 문제 해결

인쇄가 되지 않습니다.

원인 해결책

프린터가 꺼져 있고 온라인 상태가 아닙니다. 프린터를 켜서 온라인 상태인지 확인합니다.

응용프로그램에 적합한 프린터 드라이버가 설치되지 않았습
니다.

1. 응용프로그램에 적합한 프린터 드라이버를 설치합니다.

2. 다음 MS-DOS 명령을 사용하여 인쇄해 봅니다.

DIR C:\ > [프린터 포트]

[프린터 포트]는 사용할 프린터의 주소입니다. 프린터가 작동
하면, 프린터 드라이버를 다시 로드하십시오.

컴퓨터가 네트워크에 연결되어 있는 경우 프린터와 연결되지
않았을 수 있습니다.

프린터가 네트워크에 연결되어 있는지 확인합니다.

프린터에 문제가 있습니다. 프린터 자가 진단 검사를 실행합니다.

컴퓨터가 켜지지 않습니다.

원인 해결책

케이블이 제대로 연결되지 않았습니다. 모든 케이블을 다시 연결하고 전원 코드 및 전기 콘센트를 확
인합니다.

읽을 수 없는 정보를 인쇄합니다.

원인 해결책

응용프로그램에 적합한 프린터 드라이버가 설치되지 않았습
니다.

응용프로그램에 적합한 프린터 드라이버를 설치합니다.

케이블이 제대로 연결되지 않았습니다. 케이블을 모두 다시 연결합니다.

프린터 메모리가 과부하 상태입니다. 프린터를 1 분 동안 꺼서 재설정한 다음 다시 켭니다.

오프라인 상태입니다.

원인 해결책

프린터에 종이가 없습니다. 종이함을 확인하고 비어 있으면 다시 채우십시오. 온라인을 선
택합니다.
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키보드 및 마우스 문제 해결
키보드 또는 마우스 문제가 발생하면 장치와 함께 제공된 설명서 및 다음 표에 있는 일반적인 원인 및
해결 방법을 참조하십시오.

표 2-9  키보드 문제 해결

키보드 명령 및 입력을 컴퓨터가 인식하지 못합니다.

원인 해결책

키보드 연결단자가 제대로 연결되지 않았습니다. 1. Windows XP 데스크탑에서 시작 > 시스템 종료를 누릅니

다.

Windows Vista 데스크탑에서 시작을 누르고 시작 메뉴의
오른쪽 아래에 있는 화살표 단추를 누른 후 시스템 종료
를 선택합니다.

2. 시스템이 종료된 후 키보드를 컴퓨터 뒷면에 다시 연결하
고 컴퓨터를 다시 시작합니다.

사용 중인 프로그램이 명령에 응답하지 않습니다. 마우스를 사용하여 컴퓨터를 종료한 다음 다시 시작합니다.

키보드를 수리해야 합니다. 전 세계 공통 제한 보증의 조항과 조건을 확인하십시오.

무선 장치 오류입니다. 1. 가능한 경우 소프트웨어에서 장치 상태를 확인합니다.

2. 장치 배터리를 확인하거나 교체합니다.

3. 수신기 및 키보드를 재설정합니다.

컴퓨터가 대기 모드에 있습니다. 대기 모드에서 다시 계속하려면 전원 버튼을 누릅니다.

주의: 대기 모드에서 다시 계속하는 경우 전원 버
튼을 4 초 이상 누르지 마십시오. 4 초 이상 누르면 컴

퓨터가 종료되어 저장되지 않은 데이터를 잃게 됩니
다.

키패드의 화살표 키로 커서를 움직일 수 없습니다.

원인 해결책

num lock 키가 켜져 있습니다. num lock 키를 누릅니다. 키패드에서 화살표 키를 사용하
려면 Num Lock 표시등이 꺼져 있어야 합니다. num lock
키는 Computer Setup 에서 비활성화(또는 활성화)할 수 있습
니다.
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표 2-10  마우스 문제 해결

마우스가 동작에 응답하지 않거나 너무 느립니다.

원인 해결책

마우스 연결단자가 컴퓨터 뒷면에 제대로 꽂혀 있지 않습니
다.

키보드를 사용하여 컴퓨터를 종료합니다.

1. ctrl 및 esc 키를 동시에(또는 Windows 로고 키) 눌러 시

작 메뉴를 표시합니다.

2. 화살표 키를 사용하여 종료를 선택한 후 enter 키를 누릅
니다.

3. 시스템이 종료된 후에 마우스 연결단자를 컴퓨터 뒷면(또
는 키보드)에 꽂고 컴퓨터를 다시 시작합니다.

사용 중인 프로그램이 명령에 응답하지 않습니다. 키보드를 사용하여 컴퓨터를 종료한 다음 컴퓨터를 다시 시작
합니다.

마우스를 청소해야 합니다. 마우스의 롤러 볼 커버를 열고 내부를 청소합니다.

마우스를 수리해야 합니다. 전 세계 공통 제한 보증의 조항과 조건을 확인하십시오.

무선 장치 오류입니다. 1. 가능한 경우 소프트웨어에서 장치 상태를 확인합니다.

2. 장치 배터리를 확인하거나 교체합니다.

3. 수신기 및 마우스를 재설정합니다.

컴퓨터가 대기 모드에 있습니다. 대기 모드에서 다시 계속하려면 전원 버튼을 누릅니다.

주의: 대기 모드에서 다시 계속하는 경우 전원 버
튼을 4 초 이상 누르지 마십시오. 4 초 이상 누르면 컴
퓨터가 종료되어 저장되지 않은 데이터를 잃게 됩니
다.

마우스가 수직 또는 수평으로만 움직이거나 제대로 움직이지 않습니다.

원인 해결책

마우스 볼이나 볼과 맞닿는 회전 인코더 축이 더럽습니다. 마우스 밑면에서 롤러 볼 덮개를 열고 컴퓨터 매장에서 구입
할 수 있는 마우스 청소 키트로 내부 부품을 청소합니다.
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하드웨어 설치 문제 해결
추가 드라이브 또는 확장 카드와 같은 하드웨어를 추가하거나 제거하는 경우 컴퓨터를 재구성해야 할
수도 있습니다. 플러그 앤 플레이 장치를 설치할 경우 Windows 는 자동으로 장치를 인식하고 컴퓨터
를 구성합니다. 비플러그 앤 플레이 장치를 설치하는 경우 새 하드웨어를 설치한 다음 컴퓨터를 재구
성해야 합니다. Windows 의 경우 하드웨어 추가 마법사를 사용하여 화면의 지침을 따르십시오.

경고! 컴퓨터가 AC 전원에 연결되어 있는 경우 시스템 보드에 항상 전압이 흐르고 있습니다.
감전이나 뜨거운 표면으로 인한 부상의 위험이 있으므로 반드시 벽면 콘센트에서 전원 코드를
뽑고 내부 시스템 부품의 열이 식은 다음에 만지십시오.

DIMM 소켓 사이의 LED 를 확인합니다. LED 가 켜져 있으면 시스템에 여전히 전원이 들어와 있
는 것입니다. 컴퓨터를 끄고 전원 코드를 분리한 다음 작업을 진행하십시오.

표 2-11  하드웨어 설치 문제 해결

시스템에서 새 장치를 인식하지 못합니다.

원인 해결책

장치의 설치 또는 연결이 제대로 되지 않았습니다. 장치가 제대로 설치되었는지, 느슨하게 연결되지는 않았는지
그리고 연결단자의 핀이 구부러지지 않았는지 확인합니다.

새 외부 장치의 케이블이 제대로 연결되지 않았거나 전원에 꽂
혀 있지 않습니다.

모든 케이블이 제대로 연결되어 있는지 확인하고 케이블이나
연결단자의 핀이 구부러지지 않았는지 확인합니다.

새 외부 장치의 전원 스위치를 켜지 않았습니다. 컴퓨터를 끄고 외부 장치를 켠 후 다시 컴퓨터를 켜서 컴퓨터
시스템에 장치를 인식하도록 합니다.

구성이 변경되었다는 메시지가 표시되었을 때 사용자가 이를
적용하지 않았습니다.

컴퓨터를 재부팅한 후 변경 사항을 적용하는 절차를 수행합니
다.

기본 구성이 다른 장치와 충돌하는 경우, 플러그 앤 플레이 보
드를 추가하면 자동으로 구성하지 못할 수 있습니다.

Windows 장치 관리자를 사용하여 보드 자동 설정의 선택을 해
제하고 리소스 충돌을 일으키지 않는 기본 구성을 선택합니
다. Computer Setup 을 사용하여 장치를 재구성하거나 기능을
해제하여 리소스 충돌을 해결할 수도 있습니다.

컴퓨터의 USB 포트가 Computer Setup 에서 비활성화되어 있
습니다.

Computer Setup(F10)을 실행하고 USB 포트를 활성화합니
다.

컴퓨터가 시작되지 않습니다.

원인 해결책

업그레이드에 잘못된 메모리 모듈을 사용했거나 메모리 모듈
을 설치한 위치가 잘못되었습니다.

1. 시스템과 함께 제공된 설명서를 참조하여 올바른 메모리
모듈을 사용하고 있는지, 설치가 제대로 되었는지 확인합
니다.

주: DIMM 1 은 반드시 설치되어 있어야 합니
다.

2. 신호음 및 컴퓨터 앞면의 LED 표시등을 살펴 보십시오.
신호음 및 깜박이는 LED 는 특정 문제가 있음을 나타냅

니다.

3. 문제를 해결할 수 없으면 기술 지원 센터로 문의하십시
오.
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빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 5 번 깜박이고 컴퓨터 신호음이 5 번 울립니다. (신호음은 5 번 반복되었
다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

메모리가 잘못 설치되었거나 불량입니다.
주의: DIMM 또는 시스템 보드의 손상을 방지하
려면 DIMM 모듈을 다시 장착, 설치 또는 분리하기 전

에 컴퓨터 전원 코드를 뽑아야 합니다.

1. DIMM 을 다시 장착합니다. 시스템 전원을 켭니다.

2. 한 번에 하나씩 DIMM 을 교체하여 문제가 있는 모듈을
찾아 냅니다.

주: DIMM 1 은 반드시 설치되어 있어야 합니
다.

3. 타사의 메모리를 HP 메모리로 교체합니다.

4. 시스템 보드를 교체합니다.

빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 6 번 깜박이고 컴퓨터 신호음이 6 번 울립니다. (신호음은 5 번 반복되었

다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

그래픽 카드가 제대로 장착되지 않았거나 불량이거나 시스템
보드가 불량입니다.

그래픽 카드가 설치된 시스템의 경우

1. 그래픽 카드를 다시 장착합니다. 시스템 전원을 켭니다.

2. 그래픽 카드를 교체합니다.

3. 시스템 보드를 교체합니다.

통합 그래픽 카드가 내장된 시스템의 경우 시스템 보드를 교
체합니다.

빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 10 번 깜박이고 컴퓨터 신호음이 10 번 울립니다. (신호음은 5 번 반복되
었다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

옵션 카드가 불량입니다. 1. 카드가 여러 개인 경우 옵션 카드를 하나씩 빼서 확인한
다음 시스템을 켜서 문제가 해결되었는지 확인합니다.

2. 불량 카드가 확인되면 불량 옵션 카드를 다른 카드로 교
체합니다.

3. 시스템 보드를 교체합니다.

표 2-11  하드웨어 설치 문제 해결 (계속)
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네트워크 문제 해결
다음 표에 네트워크 문제의 일반적인 원인 및 해결 방법이 설명되어 있습니다. 네트워크 케이블링 문
제를 해결하는 방법은 여기에서 다루지 않습니다.

표 2-12  네트워크 문제 해결

WOL 기능이 작동하지 않습니다.

원인 해결책

WOL 기능이 활성화되어 있지 않습니다. Windows XP 에서 Wake-on-LAN 을 활성화하려면 다음과 같

이 하십시오.

1. 시작 > 제어판을 선택합니다.

2. 네트워크 연결을 두 번 누릅니다.

3. 로컬 영역 연결을 두 번 누릅니다.

4. 속성을 누릅니다.

5. 구성을 누릅니다.

6. 전원 관리 탭을 누른 다음 이 장치로 컴퓨터를 대기 상태
에서 빠져 나오게 함 확인란을 선택합니다.

Windows Vista 에서 Wake-on-LAN 을 활성화하려면 다음과

같이 하십시오.

1. 시작 > 제어판을 선택합니다.

2. 네트워크 및 인터넷에서 네트워크 상태 및 작업 보기를 선
택합니다.

3. 작업 목록에서 네트워크 연결 관리를 선택합니다.

4. 로컬 영역 연결을 두 번 누릅니다.

5. 속성 버튼을 누릅니다.

6. 구성 버튼을 누릅니다.

7. 전원 관리 탭을 누른 다음 이 장치를 사용하여 컴퓨터의
대기 모드를 종료할 수 있음 확인란을 선택합니다.

네트워크 드라이버가 네트워크 컨트롤러를 인식하지 못합니다.

원인 해결책

네트워크 컨트롤러가 비활성화 상태입니다. 1. Computer Setup 을 실행하고 네트워크 컨트롤러를 활성
화합니다.

2. 장치 관리자를 통해 운영체제의 네트워크 컨트롤러를 활
성화합니다.

네트워크 드라이버가 잘못되었습니다. 네트워크 컨트롤러 설명서를 참조하여 적합한 드라이버를 확
인하거나 제조업체의 웹 사이트에서 최신 드라이버를 다운로
드합니다.
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네트워크 연결 상태 표시등이 깜박이지 않습니다.

주: 네트워크 상태 표시등은 네트워크 연결이 활성화된 경우에 깜박이도록 되어 있습니다.

원인 해결책

네트워크 연결이 활성화되지 않았습니다. 케이블과 네트워크 장비가 제대로 연결되어 있는지 확인합니
다.

네트워크 컨트롤러가 올바로 설정되지 않았습니다. 장치 관리자에서 드라이버 로드 상태를 확인하고 Windows 의
네트워크 연결 애플릿에서 연결 상태를 확인하는 등 Windows
의 장치 상태를 확인합니다.

네트워크 컨트롤러가 비활성화 상태입니다. 1. Computer Setup 을 실행하고 네트워크 컨트롤러를 활성

화합니다.

2. 장치 관리자를 통해 운영체제의 네트워크 컨트롤러를 활
성화합니다.

네트워크 드라이버가 제대로 로드되지 않았습니다. 네트워크 드라이버를 다시 설치합니다. Documentation and
Diagnostics CD 의 네트워크 및 인터넷 통신 설명서를 참조하
십시오.

시스템이 네트워크를 자동으로 인식하지 못합니다. 자동 인식 기능을 비활성화하고 직접 시스템을 정확한 작동 모
드로 바꾸십시오. Documentation and Diagnostics CD 의 네트
워크 및 인터넷 통신 설명서를 참조하십시오.

Diagnostics 에서 오류를 발견했습니다.

원인 해결책

케이블이 단단히 연결되지 않았습니다. 케이블이 네트워크 연결단자에 단단히 연결되어 있고 케이블
의 반대쪽 끝이 올바른 장치에 제대로 연결되어 있는지 확인
합니다.

케이블이 잘못된 연결단자에 연결되었습니다. 케이블이 올바른 연결단자에 연결되었는지 확인합니다.

케이블 또는 케이블에 연결된 장치에 문제가 있습니다. 케이블 및 케이블의 반대쪽 끝에 연결된 장치가 제대로 작동
하는지 확인합니다.

네트워크 컨트롤러 인터럽트가 확장 보드와 공유되었습니다. Computer Setup Advanced 메뉴에서 보드의 리소스 설정을
변경합니다.

네트워크 컨트롤러에 결함이 있습니다. 공인 서비스 제공업체에 문의하십시오.

Diagnostics 에서는 오류를 발견하지 못했지만 컴퓨터가 네트워크와 통신할 수 없습니다.

원인 해결책

네트워크 드라이버가 로드되지 않았거나, 드라이버 매개변수
가 현재의 구성과 맞지 않습니다.

네트워크 드라이버를 로드하고 드라이버 매개변수를 네트워
크 컨트롤러의 구성에 맞게 설정합니다.

올바른 네트워크 클라이언트 및 프로토콜이 설치되었는지 확
인합니다.

네트워크 컨트롤러가 해당 컴퓨터에 맞게 구성되지 않았습니
다.

제어판에서 네트워크 아이콘을 선택하여 네트워크 컨트롤러를
구성합니다.

표 2-12  네트워크 문제 해결 (계속)
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확장 보드를 컴퓨터에 추가하자 네트워크 컨트롤러가 작동을 멈췄습니다.

원인 해결책

네트워크 컨트롤러 인터럽트가 확장 보드와 공유되었습니다. Computer Setup Advanced 메뉴에서 보드의 리소스 설정을
변경합니다.

네트워크 컨트롤러가 드라이버를 요구합니다. 새 확장 보드용 드라이버를 설치할 때 드라이버가 삭제되지 않
았는지 확인합니다.

설치된 확장 보드가 네트워크 카드(NIC)이고 내장 NIC 와 충
돌합니다.

Computer Setup Advanced 메뉴에서 보드의 리소스 설정을
변경합니다.

네트워크 컨트롤러가 뚜렷한 이유 없이 작동을 멈춥니다.

원인 해결책

네트워크 드라이버 파일이 손상되었습니다. Restore Plus! CD 를 사용하여 네트워크 드라이버를 다시 설
치합니다.

케이블이 단단히 연결되지 않았습니다. 케이블이 네트워크 연결단자에 단단히 연결되어 있고 케이블
의 반대쪽 끝이 올바른 장치에 제대로 연결되어 있는지 확인
합니다.

네트워크 컨트롤러에 결함이 있습니다. 공인 서비스 제공업체에 문의하십시오.

새 네트워크 카드가 부팅되지 않습니다.

원인 해결책

새 네트워크 카드에 결함이 있거나 산업 표준 사양에 맞지 않
습니다.

산업 표준 NIC 를 설치하거나 부팅 순서를 다른 장치로 부팅
되도록 변경합니다.

원격 시스템 설치를 실행할 때 네트워크 서버에 연결할 수 없습니다.

원인 해결책

네트워크 컨트롤러가 제대로 구성되지 않았습니다. 네트워크 연결에서 현재 DHCP 서버가 있고 원격 시스템 설치
서버에 자신의 NIC 용 NIC 드라이버가 있는지 확인합니다.

시스템 설정 유틸리티가 프로그램되지 않은 EEPROM 을 발견했습니다.

원인 해결책

프로그램화되지 않은 EEPROM 입니다. 공인 서비스 제공업체에 문의하십시오.

표 2-12  네트워크 문제 해결 (계속)
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메모리 문제 해결
메모리 문제가 발생한 경우 다음 표에 있는 일반적인 원인 및 해결 방법을 참조하십시오.

주의: 컴퓨터를 끈 경우에도 ME(Management Engine) 설정에 따라 DIMM 에 전원이 계속 공
급될 수 있습니다. DIMM 또는 시스템 보드의 손상을 방지하려면 DIMM 모듈을 다시 장착, 설치
또는 분리하기 전에 컴퓨터 전원 코드를 뽑아야 합니다.

ECC 메모리를지원하는 시스템인 경우 HP 는 ECC 와 비 ECC 메모리의 혼용을 지원하지 않습
니다. 그렇지 않은 경우 컴퓨터를 운영체제로 부팅할 수 없습니다.

주: 메모리 카운트는 설정된 ME(Management Engine) 구성에 영향을 받습니다. ME 는 단일
채널 모드에서 8MB 의 시스템 메모리 또는 이중 채널 모드에서 16MB 의 메모리를 사용하여
OOB(Out-of-Band), 타사 데이터 저장 장치 및 기타 관리 기능을 제공하는 ME 펌웨어를 다운로
드, 압축 해제 및 실행합니다.

표 2-13  메모리 문제 해결

추가 메모리 모듈 설치 후 시스템이 부팅되지 않거나 제대로 작동되지 않습니다.

원인 해결책

메모리 모듈이 XMM1 소켓에 설치되어 있지 않습니다. 시스템 보드에서 검은색 XMM1 소켓에 메모리 모듈이 설치되

어 있는지 확인합니다. 이 소켓에는 메모리 모듈이 장착되어
있어야 합니다.

메모리 모듈이 시스템에 적합한 종류가 아니거나 적절한 속도
등급을 가지고 있지 않거나 새 메모리 모듈이 제대로 설치되
지 않았습니다.

모듈을 컴퓨터에 적합한 산업 표준 장치로 교체합니다. 일부
모델에서는 ECC 또는 비 ECC 메모리 모듈을 혼용할 수 없습
니다.

메모리 부족 오류

원인 해결책

메모리 구성이 올바르게 설정되지 않았습니다. 장치 관리자를 사용하여 메모리 구성을 확인합니다.

메모리가 부족하여 응용프로그램을 실행할 수 없습니다. 응용프로그램 설명서를 참조하여 메모리 요구량을 확인합니
다.

POST 실행 중 메모리 카운트가 잘못되었습니다.

원인 해결책

메모리 모듈이 제대로 설치되지 않았습니다. 메모리 모듈이 제대로 설치되었는지, 적합한 모듈을 사용하고
있는지 확인합니다.

통합 그래픽이 시스템 메모리를 사용할 수 있습니다. 조치를 취할 필요가 없습니다.
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작동 중 메모리 부족 오류

원인 해결책

너무 많은 램 상주 프로그램(TSR)이 설치되었습니다. 필요 없는 TSR 을 삭제합니다.

응용프로그램 실행에 필요한 메모리가 부족합니다. 응용프로그램에 필요한 메모리를 확인하거나 컴퓨터에 메모
리를 추가합니다.

빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 5 번 깜박이고 컴퓨터 신호음이 5 번 울립니다. (신호음은 5 번 반복되었
다가 멈추지만 표시등은 계속 깜박입니다.)

원인 해결책

메모리가 잘못 설치되었거나 불량입니다. 1. DIMM 을 다시 장착합니다. 시스템 전원을 켭니다.

2. 한 번에 하나씩 DIMM 을 교체하여 문제가 있는 모듈을
찾아 냅니다.

3. 타사의 메모리를 HP 메모리로 교체합니다.

4. 시스템 보드를 교체합니다.

표 2-13  메모리 문제 해결 (계속)

38 2 장   전문가의 진단 없이 문제를 해결하는 방법 KOWW



프로세서 문제 해결
프로세서에 문제가 발생하면 다음 표에 있는 일반적인 원인 및 해결 방법을 참조하십시오.

표 2-14  프로세서 문제 해결

성능이 기대에 미치지 못합니다.

원인 해결책

프로세서가 뜨겁습니다. 1. 컴퓨터로의 공기 흐름이 차단되지 않았는지 확인합니다.

2. 팬이 제대로 연결되어 작동하는지 확인합니다. (일부 팬
은 필요 시에만 작동합니다.)

3. 프로세서 방열 장치가 제대로 설치되었는지 확인합니다.

빨간색 전원 표시등이 2 초 간격으로 매초마다 한 번씩 5 번 깜박입니다.

원인 해결책

프로세서가 제대로 장착되지 않았거나 설치되지 않았습니다. 1. 프로세서가 장착되어 있는지 확인합니다.

2. 프로세서를 다시 장착합니다.
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CD-ROM 및 DVD 문제 해결
CD-ROM 또는 DVD 문제가 발생하면, 다음 표에 기재된 일반적인 원인 및 해결 방법을 참조하거나 옵
션 장치와 함께 제공된 설명서를 참조하십시오.

표 2-15  CD-ROM 및 DVD 문제 해결

시스템이 CD-ROM 또는 DVD 드라이브에서 부팅되지 않습니다.

원인 해결책

장치가 Computer Setup 유틸리티에서 해제된 SATA 포트에
연결되어 있습니다.

Computer Setup 유틸리티를 실행하고 장치의 SATA 포트가
Storage > Storage Options 에 설정되어 있는지 확인합니다.

Computer Setup 유틸리티에서 Removable Media Boot 가 비
활성화되어 있습니다.

Computer Setup 유틸리티를 실행하고 Storage > Storage
Options 에서 이동식 미디어 부팅을 활성화합니다. Storage
> Boot Order 에서 CD-ROM 이 활성화되어 있는지 확인합니
다.

Computer Setup 에서 Network Server Mode 가 활성화되어 있
습니다.

Computer Setup 유틸리티를 실행하고 Security > Password
Options 에서 Network Server Mode 를 비활성화합니다.

드라이브의 CD 가 부팅용이 아닙니다. 부팅 CD 를 드라이브에 삽입합니다.

부팅 순서가 잘못되었습니다. Computer Setup 유틸리티를 실행하고 Storage > Boot Order
에서 부팅 순서를 변경합니다.

드라이브를 찾을 수 없습니다(식별할 수 없음).

원인 해결책

케이블이 느슨합니다. 케이블 연결 상태를 확인합니다.

시스템이 새로 설치한 장치를 자동으로 인식하지 못했습니
다.

32페이지의 하드웨어 설치 문제 해결 섹션의 구성 지침을 참
조하십시오. 시스템이 여전히 새 장치를 인식하지 못하는 경
우, 그 장치가 Computer Setup 목록에 있는지 확인합니다. 목
록에 있으면 드라이버 문제이지만, 목록에 없으면 하드웨어 문
제입니다.

새로 설치한 드라이브의 경우 Computer Setup 유틸리티를 실
행하여 Advanced > Power-On 에 POST Delay 를 추가해 보

십시오.

장치가 Computer Setup 에서 해제된 SATA 포트에 연결되어

있습니다.
Computer Setup 유틸리티를 실행하고 장치의 SATA 포트가

Storage > Storage Options 에 설정되어 있는지 확인합니다.

시스템을 켠 직후 드라이브 응답 속도가 느립니다. Computer Setup 을 실행하여 Advanced > Power-On
Options 에 POST Delay 를 추가해 보십시오.

CD-ROM 또는 DVD 장치가 감지되지 않거나 드라이버가 로드되지 않습니다.

원인 해결책

드라이브 연결 또는 구성이 제대로 되지 않았습니다. 옵션 장치와 함께 제공된 설명서를 참조하십시오.
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DVD 드라이브에서 동영상이 재생되지 않습니다.

원인 해결책

다른 나라에서 볼 수 있도록 만들어진 동영상일 수 있습니다. DVD 드라이브와 함께 제공된 설명서를 참조하십시오.

디코더 소프트웨어가 설치되지 않았습니다. 디코더 소프트웨어를 설치합니다.

미디어가 손상되었습니다. 미디어를 교체합니다.

Parental lock(시청 제한 기능)으로 영화 등급이 잠겨 있습니
다.

DVD 소프트웨어를 사용하여 Parental lock 을 제거합니다.

미디어가 거꾸로 설치되었습니다. 미디어를 다시 설치하십시오.

CD 트레이가 나오지 않습니다.

원인 해결책

디스크를 드라이브에 잘못 넣었습니다. 컴퓨터를 끈 다음 가는 금속 막대 끝을 비상 배출 구멍에 넣고
힘껏 누릅니다. 드라이브에서 조심스럽게 트레이를 잡아 당겨
완전히 나온 다음 디스크를 꺼냅니다.

CD-ROM, CD-RW, DVD-ROM 또는 DVD-R/RW 드라이브가 디스크를 읽을 수 없거나 시작하는 시간이 오래 걸립니다.

원인 해결책

미디어가 거꾸로 삽입되었습니다. 미디어의 레이블이 위를 향하게 하여 다시 넣습니다.

DVD-ROM 드라이브는 오디오 또는 비디오 등의 재생할 미디
어의 종류를 식별해야 하기 때문에 시작하는 데 시간이 많이
걸립니다.

DVD-ROM 드라이브가 재생할 미디어의 종류를 식별할 때까
지 최소한 30 초 이상 기다리십시오. 디스크가 여전히 재생되
지 않으면 이 섹션에 설명된 다른 해결 방법을 참조하십시오.

CD 또는 DVD 디스크가 지저분합니다. 컴퓨터 상점에서 판매하는 CD 청소용 키트로 CD 또는 DVD
를 닦습니다.

Windows 가 CD-ROM 또는 DVD-ROM 드라이브를 찾지 못합
니다.

1. 장치 관리자를 사용하여 해당 장치를 분리하거나 제거합
니다.

2. 컴퓨터를 다시 시작하고 Windows 가 CD 또는 DVD 드라
이버를 인식하도록 만듭니다.

CD 녹화 또는 복사가 어렵거나 불가능합니다.

원인 해결책

미디어 종류가 잘못되었거나 품질이 좋지 않습니다. 1. 저속으로 녹화해 보십시오.

2. 드라이브에 맞는 미디어를 사용하고 있는지 확인하십시
오.

3. 다른 상표의 미디어를 사용해 보십시오. 제조업체별로 품

질이 다양합니다.

표 2-15  CD-ROM 및 DVD 문제 해결 (계속)
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CD-ROM 또는 DVD 드라이브를 분리한 후 USDT 컴퓨터 부팅이 너무 느립니다.

원인 해결책

드라이브 케이블이 시스템 보드에 계속 연결되어 있기 때문에
시스템이 부팅 중 드라이브를 검색합니다.

시스템 보드에서 드라이브 케이블을 분리합니다.
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드라이브 키 문제 해결
드라이브 키에 문제가 발생하면 다음 표에 있는 일반적인 원인 및 해결 방법을 참조하십시오.

표 2-16  드라이브 키 문제 해결

Windows 에서 USB 드라이브 키는 드라이브 문자로 사용할 수 없습니다.

원인 해결책

마지막 물리적 드라이브 뒤에 오는 드라이브 문자는 사용할 수
없습니다.

Windows 에서 드라이브 키에 대한 기본 드라이브 문자를 변
경합니다.

USB 드라이브 키를 찾을 수 없습니다(식별할 수 없음).

원인 해결책

장치가 Computer Setup 에서 해제된 USB 포트에 연결되어 있

습니다.
Computer Setup 유틸리티를 실행하고 Security > Device
Security 에서 "All USB Ports" 및 "Front USB Ports"에 대해
"Device available"이 선택되어 있는지 확인합니다.

전원을 연결하기 전에 장치가 제대로 장착되지 않았습니다. 시스템에 전원을 연결하기 전에 장치가 USB 포트에 제대로 삽
입되었는지 확인합니다.

시스템이 USB 드라이브 키에서 부팅되지 않습니다.

원인 해결책

부팅 순서가 잘못되어 있습니다. Computer Setup 유틸리티를 실행하고 Storage > Boot Order
에서 부팅 순서를 변경합니다.

Computer Setup 유틸리티에서 Removable Media Boot 가 비
활성화되어 있습니다.

Computer Setup 유틸리티를 실행하고 Storage > Storage
Options 에서 이동식 미디어 부팅을 활성화합니다. Storage
> Boot Order 에 USB 가 설정되어 있는지 확인합니다.

장치에 있는 이미지가 부팅 가능하지 않습니다. "ROM Flash: 설정 복제: 부팅 장치 만들기: 지원되는 USB 플
래시 미디어 장치" 단원(서비스 참조 설명서)에 설명된 절차를
따르십시오.

부팅용 드라이브 키가 만들어진 후에 시스템이 DOS 로 부팅됩니다.

원인 해결책

드라이브 키가 부팅 가능합니다. 운영체제를 부팅한 다음 드라이브 키를 설치합니다.
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앞면 패널 부품 문제 해결
앞면 패널에 연결된 장치에 문제가 발생하면 다음 표에 있는 일반적인 원인 및 해결 방법을 참조하십
시오.

표 2-17  앞면 패널 부품 문제 해결

USB 장치, 헤드폰 또는 마이크를 컴퓨터가 인식하지 못합니다.

원인 해결책

장치가 제대로 연결되지 않았습니다. 1. 컴퓨터를 끕니다.

2. 컴퓨터 앞면에 장치를 다시 연결하고 컴퓨터를 다시 시작
합니다.

장치에 전원이 들어오지 않았습니다. USB 장치에 AC 전원이 필요한 경우 한쪽 끝이 장치에 연결되
어 있고 다른 한쪽 끝이 가동중인 콘센트에 연결되어 있는지
확인하십시오.

적합한 장치 드라이버가 설치되지 않았습니다. 1. 장치에 적합한 드라이버를 설치합니다.

2. 컴퓨터를 재부팅해야 할 수도 있습니다.

장치에서 컴퓨터로 연결된 케이블이 작동하지 않습니다. 1. 가능하면 케이블을 교체합니다.

2. 컴퓨터를 다시 시작합니다.

장치가 작동하지 않습니다. 1. 장치를 교체합니다.

2. 컴퓨터를 다시 시작합니다.

컴퓨터의 USB 포트가 Computer Setup 에서 비활성화되어 있
습니다.

Computer Setup(F10)을 실행하고 USB 포트를 활성화합니
다.
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인터넷 접속 문제 해결
인터넷 접속에 문제가 발생하면 인터넷 서비스 제공업체에 문의하거나 다음 표에 나온 일반 원인 및
해결 방법을 참조하십시오.

표 2-18  인터넷 접속 문제 해결

인터넷에 연결할 수 없습니다.

원인 해결책

ISP(인터넷 서비스 제공업체) 계정이 제대로 설정되지 않았습

니다.
인터넷 설정을 확인하거나 ISP 에 지원을 요청하십시오.

모뎀이 제대로 설치되지 않았습니다. 모뎀을 다시 연결합니다. 빠른 설치 설명서를 참조하여 제대
로 연결되었는지 확인합니다.

웹 브라우저가 제대로 설치되지 않았습니다. 웹 브라우저가 설치되고 해당 ISP 에서 작동하도록 설정되었
는지 확인합니다.

케이블/DSL 모뎀이 꽂혀 있지 않습니다. 케이블/DSL 모뎀을 꽂으십시오. 케이블/DSL 모뎀의 앞면에
있는 "전원" LED 표시등을 확인합니다.

나쁜 날씨로 인하여 케이블/DSL 서비스를 사용할 수 없거나

방해를 받고 있습니다.
나중에 인터넷에 연결해 보거나 ISP 에 문의하십시오. 케이

블/DSL 서비스가 연결되어 있는 경우 케이블/DSL 모뎀의 앞
면에 있는 "케이블" LED 표시등이 켜집니다.

CAT5 UTP 케이블이 연결되어 있지 않습니다. 케이블 모뎀과 컴퓨터의 RJ-45 연결단자 사이에 CAT5 UTP
케이블을 연결합니다. 연결 상태가 좋으면 케이블/DSL 모뎀의
앞면에 있는 "PC" LED 표시등이 켜집니다.

IP 주소가 제대로 구성되지 않았습니다. ISP 에 올바른 IP 주소를 문의하십시오.

쿠키에 오류가 있습니다. ("쿠키"는 웹 서버에 웹 브라우저를
임시 저장할 수 있는 작은 정보로 브라우저가 나중에 웹 서버
를 검색할 수 있도록 일부 특정 정보를 기억시키는데 유용합
니다.)

Windows Vista

1. 시작 > 제어판을 선택합니다.

2. 네트워크 및 인터넷을 누릅니다.

3. 인터넷 옵션을 누릅니다.

4. 검색 기록 섹션의 일반 탭에서 삭제 버튼을 누릅니다.

5. 쿠키 삭제 버튼을 누릅니다.

Windows XP

1. 시작 > 제어판을 선택합니다.

2. 인터넷 옵션을 두 번 누릅니다.

3. 일반 탭에서 쿠키 삭제 버튼을 누릅니다.

인터넷 프로그램을 자동으로 시작할 수 없습니다.

원인 해결책

일부 프로그램의 경우 먼저 ISP 에 로그인해야 시작됩니다. ISP 에 로그인하여 원하는 프로그램을 시작합니다.
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인터넷에서 웹 사이트를 다운로드하는 데 시간이 많이 걸립니다.

원인 해결책

모뎀이 제대로 설치되지 않았습니다. 모뎀이 제대로 연결되어 통신되고 있는지 확인합니다.

Windows XP

1. 시작 > 제어판을 선택합니다.

2. 시스템을 두 번 누릅니다.

3. 하드웨어 탭을 누릅니다.

4. 장치 관리자 영역에서 장치 관리자 버튼을 누릅니다.

5. 모뎀을 두 번 누릅니다.

6. Agere Systems PCI-SV92PP Soft Modem 을 두 번 누
릅니다.

7. 일반 탭에서 진단을 누릅니다.

8. 모뎀 쿼리를 누릅니다. “성공”이 표시되면 모뎀이 제대로
연결되어 작동하는 것입니다.

Windows Vista

1. 시작 > 제어판을 선택합니다.

2. 시스템 및 유지 관리를 누릅니다.

3. 시스템을 누릅니다.

4. 작업 목록에서 장치 관리자를 선택합니다.

5. 모뎀을 두 번 누릅니다.

6. Agere Systems PCI-SV92PP Soft Modem 을 두 번 누
릅니다.

7. 일반 탭에서 진단을 누릅니다.

8. 모뎀 쿼리를 누릅니다. “성공”이 표시되면 모뎀이 제대로
연결되어 작동하는 것입니다.

표 2-18  인터넷 접속 문제 해결 (계속)
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소프트웨어 문제 해결
대부분의 소프트웨어 문제에 대한 원인은 다음과 같습니다.

● 응용프로그램이 올바로 설치되지 않았거나 올바로 구성되지 않았습니다.

● 응용프로그램을 실행할 메모리가 불충분합니다.

● 응용프로그램 사이에 충돌이 있습니다.

● 필요한 모든 장치 드라이버가 설치되어 있는지 확인하십시오.

● 출하 시 설치한 운영체제 이외에 시스템을 설치한 경우 시스템이 지원하는지 확인합니다.

소프트웨어 문제가 발생하면 다음 표에서 알맞은 해결 방법을 참조하십시오.

표 2-19  소프트웨어 문제 해결

컴퓨터 작동이 중단되고 HP 로고 화면이 나타나지 않습니다.

원인 해결책

POST 오류가 발생했습니다. 신호음 및 컴퓨터 앞면의 LED 표시등을 살펴 보십시오. 가능

한 원인을 확인하려면 부록 A, 49페이지의 POST 오류 메시
지를 참조하십시오.

Restore Kit 또는 전 세계 공통 제한 보증의 조항과 조건을 확
인하십시오.

HP 로고 화면이 나타난 후 컴퓨터 작동이 중단됩니다.

원인 해결책

시스템 파일이 손상되었을 수 있습니다. 복구 디스켓을 사용하여 하드 드라이브에 오류가 있는지 검색
합니다.

Illegal Operation has Occurred(비정상적인 동작이 발생했습니다.)라는 오류 메시지가 표시됩니다.

원인 해결책

사용 중인 소프트웨어는 해당 버전의 Windows 버전용으로

Microsoft 가 인증한 소프트웨어가 아닙니다.
시스템에 설치된 Windows 버전용으로 Microsoft 가 인증한 소

프트웨어인지 확인합니다(프로그램 포장 상자 참조).

구성 파일이 손상되었습니다. 가능한 경우 모든 데이터를 저장하고 모든 프로그램을 닫은 후
컴퓨터를 다시 시작합니다.
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고객 지원 센터 문의
지원 및 서비스가 필요하면 공인 판매업체 또는 대리점에 문의하십시오. 가까운 판매업체 또는 대리점
을 찾으려면 http://www.hp.com 을 참조하십시오.

주: 서비스를 받기 위해 공인 판매업체, 대리점, 또는 서비스 제공업체로 컴퓨터를 가져올 경
우 파워온 암호 및 설정 암호(설정된 경우)를 알려주십시오.

기술 지원에 대한 정보는 보증서 또는 Documentation and Diagnostics CD 의 고객 지원 센터 전
화 번호 설명서의 번호를 참조하십시오.
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A POST 오류 메시지

이 부록에서는 POST(전원 켤 때 자체 테스트) 또는 컴퓨터 재시작 중 발생할 수 있는 오류 코드, 오류
메시지, 다양한 표시등 및 신호음 순서, 가능한 문제 발생 원인, 오류 조건을 해결하는 절차 등을 설명
합니다.

POST Message Disabled(POST 메시지 표시 안 함) 모드를 설정하면 POST 중 표시되는 대부분의 시
스템 메시지(예: 메모리 카운트 및 오류 메시지가 아닌 텍스트 메시지)가 나타나지 않도록 합니다.
POST 오류가 발생하면, 화면에 오류 메시지가 표시됩니다. POST 중 수동으로 POST Messages
Enabled 모드로 전환하려면 f10 또는 f12 키 이외의 아무 키나 누르십시오. 기본 모드는 POST
Message Disabled 입니다.

컴퓨터가 운영체제를 로드하는 속도와 컴퓨터 테스트의 범위는 POST 모드 선택에 따라 결정됩니다.

Quick Boot(빠른 부팅)는 시스템 레벨 테스트 중 일부(예: 메모리 테스트)를 실행하지 않는 빠른 시동
프로세스입니다. Full Boot(정식 부팅)는 ROM 기반의 시스템 테스트를 모두 실행하며 오랜 시간이 걸
립니다.

정기적으로 1-30 일마다 Full Boot(정식 부팅)가 실행되도록 일정을 설정할 수도 있습니다. 일정을 설정
하려면, Computer Setup 에서 Full Boot Every x Days 모드로 재구성하십시오.

주: Computer Setup 에 대한 자세한 내용은 Documentation and Diagnostics CD 의
Computer Setup(F10) 유틸리티 설명서를 참조하십시오.
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POST 숫자 코드 및 문자 메시지
이 섹션에서는 POST 와 관련된 숫자 코드로 이루어진 POST 오류에 대해 설명합니다. 또한 POST 중
표시될 수 있는 일부 문자 메시지도 설명합니다.

주: 화면에 POST 문자 메시지가 표시된 후 신호음이 한 번 울립니다.

표 A-1  숫자 코드 및 문자 메시지

제어판 메시지 설명 권장 조치

101-Option ROM Checksum Error 시스템 ROM 또는 확장 보드 옵션 ROM 체크
섬 오류입니다.

1. ROM 이 맞는지 확인합니다.

2. 필요하면 ROM 을 플래시합니다.

3. 최근에 확장 보드를 추가한 경우 확장 보
드를 제거해도 문제가 발생하는지 확인
합니다.

4. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

5. 메시지가 사라지면 확장 카드 문제일 수
있습니다.

6. 시스템 보드를 교체합니다.

103-System Board Failure DMA 또는 타이머 오류입니다. 1. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

2. 확장 보드를 제거합니다.

3. 시스템 보드를 교체합니다.

110-Out of Memory Space for Option ROMs 최근에 추가된 PCI 확장 카드에 POST 동안
다운로드하기에 너무 큰 옵션 ROM 이 있습
니다.

1. 최근에 PCI 확장 카드를 추가한 경우
PCI 확장 카드를 제거해도 문제가 발생
하는지 확인합니다.

2. Computer Setup 에서 Advanced >
Device Options > NIC PXE Option
ROM Download 를 DISABLE 로 설정
하면 POST 동안 내장 NIC PXE 옵션
ROM 의 다운로드를 방지하여 확장 카

드 옵션 ROM 에 필요한 메모리를 확보
할 수 있습니다. 내장 PXE 옵션 ROM
은 NIC 에서 PXE 서버로 부팅하는 데 사

용됩니다.

3. Computer Setup 에서 ACPI/USB
Buffers @ Top of Memory 설정이 활성
화되어 있는지 확인합니다.

162-System Options Not Set 구성이 잘못되었습니다.

RTC(실시간 시계) 배터리를 교체해야 합니
다.

Computer Setup 을 실행하여 Advanced >
Onboard Devices 의 구성을 확인합니다.

제어판에서 날짜와 시간을 재설정합니다. 문
제가 지속되면 RTC 배터리를 교체합니다. 새
배터리 설치에 관한 자세한 방법은
Documentation and Diagnostics CD 의 하드
웨어 참조 설명서를 참조하고, RTC 배터리를
교체하려면 공인 판매업체 또는 대리점에 문
의하십시오.

50 부록 A   POST 오류 메시지 KOWW



제어판 메시지 설명 권장 조치

163-Time & Date Not Set 구성 메모리의 시간 또는 날짜가 잘못되었습
니다.

RTC(실시간 시계) 배터리를 교체해야 합니

다.

제어판에서 날짜와 시간을 다시 설정합니다
(Computer Setup 에서도 설정 가능). 문제가
지속되면 RTC 배터리를 교체합니다. 새 배터
리 설치에 관한 자세한 방법은
Documentation and Diagnostics CD 의 하드
웨어 참조 설명서를 참조하고, RTC 배터리를

교체하려면 공인 판매업체 또는 대리점에 문
의하십시오.

163-Time & Date Not Set CMOS 점퍼가 제대로 설치되지 않았습니다. CMOS 점퍼가 있는 경우 점퍼의 위치가 올바
른지 확인합니다.

164-MemorySize Error 마지막으로 부팅한 후 메모리 용량이 변경되
었습니다(메모리가 추가 또는 제거됨).

f1 키를 눌러 메모리 변경 사항을 저장합니
다.

164-MemorySize Error 메모리 구성이 잘못되었습니다. 1. Computer Setup 또는 Windows 유틸리
티를 실행합니다.

2. 메모리 모듈이 제대로 설치되어 있는지
확인합니다.

3. 추가한 메모리가 타 업체 제품일 경우
HP 전용 메모리를 사용하여 테스트합니
다.

4. 메모리 모듈 유형이 적합한지 확인합니
다.

201-Memory Error RAM 오류입니다. 1. Computer Setup 또는 Windows 유틸리
티를 실행합니다.

2. 메모리 모듈이 제대로 설치되어 있는지
확인합니다.

3. 메모리 모듈 유형이 적합한지 확인합니
다.

4. 문제가 있는 것으로 확인된 메모리 모듈
을 제거하고 교체합니다.

5. 메모리 모듈 교체 후에도 오류가 지속되
면 시스템 보드를 교체합니다.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

오류 메시지에 표시된 메모리 소켓에 있는 메
모리 모듈에 반드시 있어야 할 SPD 정보가
없거나 칩셋과 호환되지 않습니다.

1. 메모리 모듈 유형이 적합한지 확인합니
다.

2. 다른 메모리 소켓을 사용해 봅니다.

3. DIMM 을 SPD 표준을 준수하는 모듈로

교체합니다.

214-DIMM Configuration Warning 설치된 DIMM 구성이 최적화되지 않았습니
다.

각 채널의 메모리 크기가 동일하도록 DIMM
을 재배치합니다.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

최근에 추가된 메모리 모듈이 ECC 메모리 오
류 보정을 지원합니다.

1. 최근에 메모리를 추가한 경우 메모리를
제거해도 문제가 발생하는지 확인합니
다.

2. 메모리 지원 정보에 대한 제품 설명서를
확인합니다.

표 A-1  숫자 코드 및 문자 메시지 (계속)
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제어판 메시지 설명 권장 조치

301-Keyboard Error 키보드 오류입니다. 1. 컴퓨터를 끈 상태에서 키보드를 다시 연
결합니다.

2. 연결단자 핀이 구부러지거나 없어지지
않았는지 확인합니다.

3. 눌려진 키가 없는지 확인합니다.

4. 키보드를 교체합니다.

303-Keyboard Controller Error I/O 보드 키보드 컨트롤러 1. 컴퓨터를 끈 상태에서 키보드를 다시 연
결합니다.

2. 시스템 보드를 교체합니다.

304-Keyboard or System Unit Error 키보드 오류입니다. 1. 컴퓨터를 끈 상태에서 키보드를 다시 연
결합니다.

2. 눌려진 키가 없는지 확인합니다.

3. 키보드를 다시 설치합니다.

4. 시스템 보드를 교체합니다.

404-Parallel Port Address Conflict Detected 내부 포트와 외부 포트 모두 병렬 포트 X 로
지정되었습니다.

1. 병렬 포트 확장 카드를 모두 제거합니
다.

2. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

3. 카드 리소스를 재구성하거나 Computer
Setup 을 실행합니다.

410-Audio Interrupt Conflict IRQ 주소가 다른 장치와 충돌합니다. Computer Setup 을 시작하여 Advanced >
Onboard Devices 에서 IRQ 를 다시 설정합
니다.

411-Network Interface Card Interrupt
Conflict

IRQ 주소가 다른 장치와 충돌합니다. Computer Setup 을 시작하여 Advanced >
Onboard Devices 에서 IRQ 를 다시 설정합
니다.

501-Display Adapter Failure 그래픽 디스플레이 컨트롤러 오류입니다. 1. 그래픽 카드가 있는 경우 다시 설치합니
다.

2. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

3. 모니터가 연결되어 있고 켜져 있는지 확
인합니다.

4. 가능한 경우 그래픽 카드를 교체합니
다.

510-Flash Screen Image Corrupted 플래시 화면 이미지 오류입니다. 최신 BIOS 이미지로 시스템 ROM 을 갱신합
니다.

511-CPU, Rear, or Front Fan not detected CPU 팬이 연결되어 있지 않거나 작동하는 데

문제가 있습니다.
1. CPU 팬을 다시 설치합니다.

2. 팬 케이블을 다시 설치합니다.

3. CPU 팬을 교체합니다.

표 A-1  숫자 코드 및 문자 메시지 (계속)
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제어판 메시지 설명 권장 조치

512-Chassis, Rear Chassis, or Front
Chassis Fan not Detected

섀시, 뒷면 섀시 또는 앞면 섀시 팬이 연결되
어 있지 않거나 작동하지 않습니다.

1. 섀시, 뒷면 섀시 또는 앞면 섀시 팬을 다
시 설치합니다.

2. 팬 케이블을 다시 설치합니다.

3. 섀시, 뒷면 섀시 또는 앞면 섀시 팬을 교

체합니다.

514-CPU or Chassis Fan not Detected CPU 또는 섀시 팬이 연결되어 있지 않거나
작동하지 않습니다.

1. CPU 또는 섀시 팬을 다시 설치합니다.

2. 팬 케이블을 다시 설치합니다.

3. CPU 또는 섀시 팬을 교체합니다.

601-Diskette Controller Error 디스켓 컨트롤러 회로 또는 플로피 드라이브
회로가 잘못되었습니다.

1. Computer Setup 을 실행합니다.

2. 케이블 연결 상태를 확인하거나 교체합
니다.

3. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

4. 디스켓 드라이브를 교체합니다.

5. 시스템 보드를 교체합니다.

605-Diskette Drive Type Error 드라이브 유형이 맞지 않습니다. 1. Computer Setup 을 실행합니다.

2. 다른 디스켓 컨트롤러 장치(테이프 드라
이브)를 분리합니다.

3. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

610-External Storage Device Failure 외부 테이프 드라이브가 연결되어 있지 않습
니다.

테이프 드라이브를 다시 설치하거나 f1 키를
눌러 시스템이 드라이브가 없는 상태에서 재
구성되도록 합니다.

611-Primary Floppy Port Address
Assignment Conflict

구성 오류입니다 Computer Setup 을 실행하여 Advanced >
Onboard Devices 의 구성을 확인합니다.

660-Display cache is detected unreliable 통합 그래픽 컨트롤러 디스플레이 캐시가 제
대로 작동하지 않으므로 사용할 수 없습니
다.

약간의 그래픽 품질 저하도 문제가 된다면 시
스템 보드를 교체합니다.

912-Computer Cover Has Been Removed
Since Last System Startup

마지막 시스템 시동 이후 컴퓨터 덮개를 닫지
않았습니다.

조치를 취할 필요가 없습니다.

917-Front Audio Not Connected 앞면 오디오 케이블이 마더보드에서 분리되
어 있거나 제대로 장착되지 않았습니다.

앞면 오디오 케이블을 다시 연결하거나 교체
하십시오.

918-Front USB Not Connected 앞면 USB 케이블이 마더보드에서 분리되어
있거나 제대로 장착되지 않았습니다.

앞면 USB 케이블을 다시 연결하거나 교체하
십시오.

921-Device in PCI Express slot failed to
initialize

이 장치와 시스템에 비호환성/문제가 있
거나 PCI Express Link 를 x1 로 변환할 수 없

습니다.

시스템을 재부팅해 보십시오. 오류가 다시 발
생하면 이 시스템에서 작동하지 않는 장치일
수도 있습니다.
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1151-Serial Port A Address Conflict
Detected

외부 및 내부 직렬 포트가 모두 COM1 에 할
당되어 있습니다.

1. 직렬 포트 확장 카드를 모두 제거합니
다.

2. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

3. 카드 리소스를 재구성하거나 Computer
Setup 또는 Windows 유틸리티를 실행

합니다.

1152-Serial Port B Address Conflict
Detected

외부 및 내부 직렬 포트가 모두 COM2 에 할
당되어 있습니다.

1. 직렬 포트 확장 카드를 모두 제거합니
다.

2. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

3. 카드 리소스를 재구성하거나 Computer
Setup 또는 Windows 유틸리티를 실행
합니다.

1155-Serial Port Address Conflict Detected 외부 및 내부 직렬 포트가 동일한 IRQ 에 할
당되어 있습니다.

1. 직렬 포트 확장 카드를 모두 제거합니
다.

2. CMOS 를 제거합니다. (부록 B,
60페이지의 암호 보안 및 CMOS 재설
정을 참조하십시오.)

3. 카드 리소스를 재구성하거나 Computer
Setup 또는 Windows 유틸리티를 실행
합니다.

1201-System Audio Address Conflict
Detected

장치 IRQ 주소가 다른 장치와 충돌합니다. Computer Setup 을 시작하여 Advanced >
Onboard Devices 에서 IRQ 를 다시 설정합
니다.

1202-MIDI Port Address Conflict Detected 장치 IRQ 주소가 다른 장치와 충돌합니다. Computer Setup 을 시작하여 Advanced >
Onboard Devices 에서 IRQ 를 다시 설정합
니다.

1203-Game Port Address Conflict Detected 장치 IRQ 주소가 다른 장치와 충돌합니다. Computer Setup 을 시작하여 Advanced >
Onboard Devices 에서 IRQ 를 다시 설정합

니다.

1720-SMART Hard Drive Detects Imminent
Failure

하드 드라이브에 문제가 있습니다. (일부 하
드 드라이브에는 잘못된 오류 메시지를 수정
하는 하드 드라이브 펌웨어 패치가 있습니
다.)

1. 하드 드라이브의 오류 메시지가 정확한
지 확인합니다. Computer Setup 을 시
작하고 Storage > DPS Self-test 에서
DPS(드라이브 보호 시스템) 테스트를

실행합니다.

2. 가능한 경우 하드 드라이브 펌웨어 패치
를 사용합니다. (http://www.hp.com/
support 를 참조하십시오.)

3. 하드 드라이브의 내용을 백업하고 하드
드라이브를 교체합니다.

1796-SATA Cabling Error 1 개 이상의 SATA 장치가 잘못 연결되었습니
다. 최고의 성능을 유지하려면 SATA 0 및
SATA 1 연결단자를 SATA 2 와 SATA 3 보다
먼저 사용해야 합니다.

SATA 연결단자를 오름차순으로 사용하고 있
는지 확인합니다. 장치가 1 개인 경우 SATA
0 을, 장치가 2 개인 경우 SATA 0 및 SATA 1
을, 장치가 3 개인 경우 SATA 0, SATA 1 및

SATA 2 를 사용하십시오.
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제어판 메시지 설명 권장 조치

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock 이 하나 이상의 SATA 하드 드라이
브에 설정되어 있지만 시스템이 RAID 모드로
구성된 동안에는 여기에 액세스할 수 없습니
다.

Drivelocked SATA 장치를 제거하거나
Drivelock 기능을 비활성화합니다. Drivelock
기능을 비활성화하려면 Computer Setup 을
실행하고 Storage > Storage Options >
SATA Emulation 을 IDE 로 변경한 다음
File > Save Changes and Exit 를 선택합니
다. Computer Setup 을 다시 실행하고
Security > Drivelock 을 선택합니다.
Drivelock 지원 SATA 장치로 나열된 각 장치
에서 Drivelock 이 Disabled 되어 있는지 확

인합니다. 마지막으로 Storage > Storage
Options > SATA Emulation 을 다시 RAID
로 바꾼 다음 File > Save Changes and Exit
를 선택합니다.

1801-Microcode Patch Error ROM BIOS 가 프로세서를 지원하지 않습니
다.

1. BIOS 를 적합한 버전으로 업그레이드합
니다.

2. 프로세서를 변경합니다.

2200-PMM Allocation Error during MEBx
Download

ME(Management Engine) BIOS 확장 옵션
ROM 의 POST 실행 중 메모리 오류

1. 컴퓨터를 재부팅합니다.

2. 전원 코드를 뽑고 메모리 모듈을 다시 장
착한 다음 컴퓨터를 재부팅합니다.

3. 메모리 구성이 최근에 변경된 경우 컴퓨
터 전원을 뽑고 원래의 메모리 구성을 복
원한 다음 컴퓨터를 재부팅합니다.

4. 오류가 지속되면 시스템 보드를 교체합
니다.

2201-MEBx Module did not checksum
correctly

ME(Management Engine) BIOS 확장 옵션

ROM 의 POST 실행 중 메모리 오류

1. 컴퓨터를 재부팅합니다.

2. 전원 코드를 뽑고 메모리 모듈을 다시 장
착한 다음 컴퓨터를 재부팅합니다.

3. 메모리 구성이 최근에 변경된 경우 전원
코드를 뽑고 원래의 메모리 구성을 복원
한 다음 컴퓨터를 재부팅합니다.

4. 오류가 지속되면 시스템 보드를 교체합
니다.

2202-PMM Deallocation Error during MEBx
cleanup

ME(Management Engine) BIOS 확장 옵션
ROM 의 POST 실행 중 메모리 오류

1. 컴퓨터를 재부팅합니다.

2. 전원 코드를 뽑고 메모리 모듈을 다시 장
착한 다음 컴퓨터를 재부팅합니다.

3. 메모리 구성이 최근에 변경된 경우 전원
코드를 뽑고 원래의 메모리 구성을 복원
한 다음 컴퓨터를 재부팅합니다.

4. 오류가 지속되면 시스템 보드를 교체합
니다.

2203-Setup error during MEBx execution MEBx 선택 또는 종료로 인해 설치가 실패합
니다.

1. 컴퓨터를 재부팅합니다.

2. 전원 코드를 뽑고 메모리 모듈을 다시 장
착한 다음 컴퓨터를 재부팅합니다.

표 A-1  숫자 코드 및 문자 메시지 (계속)
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3. 메모리 구성이 최근에 변경된 경우 전원
코드를 뽑고 원래의 메모리 구성을 복원
한 다음 컴퓨터를 재부팅합니다.

4. 오류가 지속되면 시스템 보드를 교체합
니다.

2204-Inventory error during MEBx execution MEBx 에 전달된 BIOS 정보로 인해 오류가
발생했습니다.

1. 컴퓨터를 재부팅합니다.

2. 오류가 지속되면 최신 BIOS 버전으로
업데이트합니다.

3. 그래도 오류가 지속되면 시스템 보드를
교체합니다.

2205-Interface error during MEBx execution ME 와의 통신 중 MEBx 운영에 하드웨어 오
류가 발생했습니다.

1. 컴퓨터를 재부팅합니다.

2. 오류가 지속되면 최신 BIOS 버전으로
업데이트합니다.

3. 그래도 오류가 지속되면 시스템 보드를
교체합니다.

Invalid Electronic Serial Number 전자 일련 번호가 누락되었습니다. Computer Setup 에 올바른 일련 번호를 입력

합니다.

Network Server Mode Active and No
Keyboard Attached

네트워크 서버 모드를 활성화한 동안 키보드
오류가 발생했습니다.

1. 컴퓨터를 끈 상태에서 키보드를 다시 연
결합니다.

2. 연결단자 핀이 구부러지거나 없어지지
않았는지 확인합니다.

3. 눌려진 키가 없는지 확인합니다.

4. 키보드를 교체합니다.

Parity Check 2 패러티 RAM 오류입니다. Computer Setup 및 Diagnostics 유틸리티를
실행합니다.

System will not boot without fan VSFF 섀시에서 CPU 팬이 설치되어 있지 않
거나 연결되어 있지 않습니다.

1. 컴퓨터 덮개를 분리하고, 전원 버튼을
눌러서 프로세서 팬이 돌아가는지 확인
합니다. 프로세서 팬이 돌지 않는 경우

팬 케이블이 시스템 보드 헤더에 연결되
어 있는지 확인합니다. 방열 장치가 제

대로 장착되고 설치되어 있는지 확인합
니다.

2. 팬 케이블이 연결되어 있고 방열 장치가
제대로 장착되어 있지만 팬이 작동하지
않는 경우 방열 장치 팬 어셈블리를 교
체합니다.

표 A-1  숫자 코드 및 문자 메시지 (계속)

56 부록 A   POST 오류 메시지 KOWW



POST 진단 앞면 패널 LED 및 소리 신호 해석
이 섹션에서는 POST 중이나 전에 발생할 수 있는 소리 신호와 키보드, 앞면 패널 표시등 코드에 대해
설명합니다. 이러한 코드는 특별한 오류 코드나 문자 메시지를 동반하지 않습니다.

경고! 컴퓨터가 AC 전원에 연결되어 있는 경우 시스템 보드에 항상 전압이 흐르고 있습니다.
감전이나 뜨거운 표면으로 인한 부상의 위험이 있으므로 반드시 벽면 콘센트에서 전원 코드를
뽑고 내부 시스템 부품의 열이 식은 다음에 만지십시오.

DIMM 소켓 사이의 LED 를 확인합니다. LED 가 켜져 있으면 시스템에 여전히 전원이 들어와 있
는 것입니다. 컴퓨터를 끄고 전원 코드를 분리한 다음 작업을 진행하십시오.

주: PS/2 키보드에 표시등이 깜박일 경우 컴퓨터 앞면 패널의 깜박이는 표시등을 살펴보고 다
음 표를 참조하여 앞면 패널 표시등 코드를 확인합니다.

다음 표의 권장 조치는 수행해야 할 순서대로 나열되어 있습니다.

모델에 따라 일부 진단 표시등 및 소리 신호를 사용할 수 없습니다.

표 A-2  진단 앞면 패널 표시등(LED) 및 소리 신호

작동 신호음 예상 원인 권장 조치

녹색 전원 표시등이 켜져 있음 없음 컴퓨터가 켜져 있음 없음

2 초마다 녹색 전원 표시등이
깜박임

없음 컴퓨터가 RAM 일시 정지
모드(특정 모델에만 해당)
또는 일반 일시 정지 모드
상태에 있음

필요한 조치 없음. 키를 누르거나 마우스를 움직
이면 컴퓨터가 작동합니다.

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 2 번

깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

2 다음과 같은 경우에 프로
세서 과열 방지 기능이 작
동됩니다.

팬이 걸려서 움직이지 않
거나 돌아가지 않는 경우

또는

방열 장치/팬 어셈블리가
프로세서에 제대로 장착되
어 있지 않는 경우

1. 컴퓨터 통풍구가 막히지 않고 프로세서 냉각
팬이 작동하는지 확인합니다.

2. 덮개를 열고 전원 버튼을 누른 후 프로세서
팬이 돌아가는지 확인합니다. 프로세서 팬이
돌지 않는 경우 팬 케이블이 시스템 보드 헤
더에 연결되어 있는지 확인합니다.

3. 팬이 꽂혀 있지만 돌고 있지 않으면 방열 장
치/팬 어셈블리를 교체하십시오.

4. 공인 판매업체 또는 서비스 제공업체에 문의
합니다.

빨간색 전원 표시등이 2 초 간

격으로 매초마다 한 번씩 3 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

3 프로세서가 제대로 설치되
어 있지 않음(프로세서 불
량 표시가 아님)

1. 프로세서가 장착되어 있는지 확인합니다.

2. 프로세서를 다시 장착합니다.
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작동 신호음 예상 원인 권장 조치

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 4 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

4 전원 실패(전원 공급 장치
과부하)

1. 덮개를 열고 4 선 또는 6 선 전원 공급 장치
케이블이 시스템 보드의 연결단자에 연결되
어 있는지 확인합니다.

2. 설치된 모든 장치(하드, 디스켓 또는 광 드라
이브 및 확장 카드 등)를 제거하고 장치에 문
제가 있는지 확인합니다. 시스템 전원을 켭니
다. 시스템이 POST 로 진입한 다음 오류를
찾을 때까지 한 번에 하나씩 장치의 전원을
끄고 다시 설치하는 과정을 반복합니다. 문제
의 원인이 되는 장치를 교체합니다. 한 번에

하나씩 장치를 계속 추가하여 모든 장치가 제
대로 작동하는지 확인합니다.

3. 전원 공급 장치를 교체합니다.

4. 시스템 보드를 교체합니다.

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 5 번
깜박임. 신호음은 5 번 반복되

었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

5 사전 비디오 메모리 오류
주의: DIMM 또는 시스템 보드의 손상을
방지하려면 DIMM 모듈을 다시 장착, 설
치 또는 분리하기 전에 컴퓨터 전원 코드
를 뽑아야 합니다.

1. DIMM 을 다시 장착합니다.

2. 한 번에 하나씩 DIMM 을 교체하여 문제가 있

는 모듈을 찾아 냅니다.

3. 타사의 메모리를 HP 메모리로 교체합니다.

4. 시스템 보드를 교체합니다.

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 6 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

6 사전 비디오 그래픽 오류 그래픽 카드가 설치된 시스템의 경우

1. 그래픽 카드를 다시 장착합니다.

2. 그래픽 카드를 교체합니다.

3. 시스템 보드를 교체합니다.

통합 그래픽 카드가 내장된 시스템의 경우 시스템
보드를 교체합니다.

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 7 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

7 시스템 보드 오류(비디오
보다 ROM 에서 먼저 오류
가 감지됨)

시스템 보드를 교체합니다.

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 8 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

8 잘못된 체크섬에 기반하는
부적합한 ROM

1. 최신 BIOS 이미지로 시스템 ROM 을 갱신합
니다. 자세한 내용은 Documentation and
Diagnostics CD 의 데스크탑 관리 설명서
에서 "부트 블록 응급 복구 모드" 단원을 참

조하십시오.

2. 시스템 보드를 교체합니다.

표 A-2  진단 앞면 패널 표시등(LED) 및 소리 신호 (계속)
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작동 신호음 예상 원인 권장 조치

빨간색 전원 표시등이 2 초 간
격으로 매초마다 한 번씩 9 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

9 시스템 전원을 켰으나 부
팅되지 않습니다.

1. 전원 공급 장치 뒷면의 전원 선택 스위치가
적정 전압으로 설정되어 있는지 확인합니다
(일부 모델만 해당). 적정 전압 설정은 해당
지역에 따라 다릅니다.

2. 컴퓨터에서 AC 전원 코드를 뽑고 30 초 간 기

다린 후 전원 코드를 다시 꽂습니다.

3. 시스템 보드를 교체합니다.

4. 프로세서를 교체합니다.

빨간색 전원 표시등이 2 초 간

격으로 매초마다 한 번씩 10 번
깜박임. 신호음은 5 번 반복되
었다가 멈추지만 표시등은 문
제가 해결될 때까지 깜박입니
다.

10 옵션 카드가 불량입니다. 1. 카드가 여러 개인 경우 옵션 카드를 하나씩
빼서 확인한 다음 시스템을 켜서 문제가 해
결되었는지 확인합니다.

2. 불량 카드가 확인되면 불량 옵션 카드를 다
른 카드로 교체합니다.

3. 시스템 보드를 교체합니다.

시스템 전원이 켜지지 않고 표
시등이 깜박이지 않음

없음 시스템 전원을 켤 수 없습
니다.

4 초보다 짧게 전원 버튼을 누릅니다. 하드 드라이

브 표시등에 녹색 불이 켜지면 전원 버튼이 제대
로 작동하는 것입니다. 다음을 시도해 보십시오.

1. 전원 공급 장치 뒷면의 전원 선택 스위치(일
부 모델만 해당)가 적정 전압으로 설정되어
있는지 확인합니다. 적정 전압 설정은 해당
지역에 따라 다릅니다.

2. 시스템 보드를 교체합니다.

또는

4 초보다 짧게 전원 버튼을 누릅니다. 하드 드라이

브 표시등에 녹색 불이 켜지지 않으면 다음 작업
을 수행하십시오.

1. 전원 케이블이 정상적으로 작동하는 AC 콘
센트에 꽂혀 있는지 확인합니다.

2. 덮개를 열고 전원 버튼 케이블이 시스템 보
드에 제대로 연결되어 있는지 확인합니다.

3. 2 개의 전원 공급 장치 케이블이 모두 시스템
보드에 제대로 연결되어 있는지 확인합니다.

4. 시스템 보드의 5V_aux 표시등이 켜져 있는
지 확인합니다. 켜져 있으면 전원 버튼 케이

블을 교체합니다. 문제가 지속되면 시스템 보
드를 교체합니다.

5. 시스템 보드의 5V_aux 표시등이 켜지지 않
으면 시스템 보드의 5V_aux 표시등이 켜질

때까지 한 번에 하나씩 확장 카드를 분리합
니다. 문제가 지속되면 전원 공급 장치를 교

체합니다.

표 A-2  진단 앞면 패널 표시등(LED) 및 소리 신호 (계속)
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B 암호 보안 및 CMOS 재설정

이 컴퓨터는 보안 암호 기능을 지원하며 Computer Setup 유틸리티 메뉴를 통해 이 기능을 설정할 수
있습니다.

이 컴퓨터는 Computer Setup 유틸리티 메뉴를 통해 설정할 수 있는 2 개의 보안 암호 기능, 즉 설정 암
호와 파워온 암호 기능을 지원합니다. 설정 암호만을 설정하면 다른 사용자는 Computer Setup 을 제
외한 컴퓨터의 모든 정보를 사용할 수 있습니다. 파워온 암호만을 설정하면 Computer Setup 및 컴퓨
터 상의 모든 정보를 액세스할 때 파워온 암호가 필요합니다. 두 암호를 모두 설정하면 설정 암호만
으로 Computer Setup 에 액세스할 수 있습니다.

두 암호를 모두 설정하면 컴퓨터에 로그인할 때 파워온 암호 대신 설정 암호를 사용할 수도 있습니다.
이 기능은 네트워크 관리자에게 유용합니다.

암호를 잊어버릴 경우 다음 두 가지 방법으로 암호를 지워 컴퓨터 상의 정보에 액세스할 수 있습니다.

● 암호 점퍼 재설정

● Computer Setup 에서 출하 시 설정을 기본값으로 복원

주의: CMOS 버튼을 누르면 CMOS 값이 출하 시 기본값으로 재설정됩니다. 나중에 필요할 것
을 대비하여 재설정하기 전에 컴퓨터 CMOS 설정을 백업해야 합니다. 백업 시 Computer Setup
을 사용하면 편리합니다. CMOS 설정을 백업하는 방법은 Documentation and Diagnostics CD
의 Computer Setup(F10) 유틸리티 설명서를 참조하십시오.
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암호 점퍼 재설정
파워온 암호 또는 설정 암호 기능을 비활성화하거나 암호를 지우려면 다음 절차를 수행하십시오.

1. 운영체제를 정상적으로 종료한 다음 컴퓨터와 모든 외부 장치의 전원을 끄고 콘센트에서 전원 코
드를 뽑습니다.

2. 전원 코드를 뽑은 상태에서 전원 버튼을 다시 눌러 시스템에 남아 있는 전력을 모두 소진시킵니
다.

경고! 감전이나 뜨거운 표면으로 인한 부상의 위험이 있으므로 반드시 벽면 콘센트에서
전원 코드를 뽑고 내부 시스템 부품의 열이 식은 다음에 만지십시오.

주의: 컴퓨터에 전원이 연결되어 있으면 장치가 꺼진 상태에서도 전원 공급 장치는 항상
시스템 보드에 입력되는 전압을 유지하고 있습니다. 전원 코드를 잘못 뽑으면 시스템에 손
상을 줄 수 있습니다.

정전기는 컴퓨터나 장비(선택 사양)의 전자 부품을 손상시킬 수 있습니다. 아래 절차를 시
작하기 전에 접지된 금속 물체를 손으로 잠깐 만져서 정전기를 미리 방전하십시오. 자세한
내용은 Documentation and Diagnostics CD 의 안전 및 규제 정보 설명서를 참조하십시오.

3. 컴퓨터 커버나 액세스 패널을 엽니다.

4. 헤더 및 점퍼를 찾습니다.

주: 암호 점퍼는 녹색이므로 쉽게 찾을 수 있습니다. 암호 점퍼와 기타 보드 구성 요소를
찾으려면 해당 시스템을 위한 IPM(Illustrated Parts Map)을 참조하십시오. IPM 은
http://www.hp.com/support 에서 다운로드할 수 있습니다.

5. 핀 1 과 핀 2 에서 점퍼를 뺍니다. 잃어버리지 않도록 핀 1 이나 핀 2 에 점퍼를 끼워둡니다.

6. 컴퓨터 덮개나 액세스 패널을 다시 장착합니다.

7. 외부 장치를 다시 연결합니다.

8. 컴퓨터에 전원을 연결하고 켭니다. 운영체제가 시작됩니다. 이 작업으로 현재의 암호가 지워지고
암호 기능이 해제됩니다.

9. 새 암호를 설정하려면 1~4 단계를 반복하고, 핀 1 과 핀 2 의 암호 점퍼를 바꾼 다음 6~8 단계를 반
복합니다. 그 다음 Computer Setup 을 통해 새 암호를 설정합니다. Computer Setup 에 대한 자세
한 내용은 Documentation and Diagnostics CD 의 Computer Setup(F10) 유틸리티 설명서를 참조
하십시오.
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CMOS 삭제 및 재설정
컴퓨터의 구성 메모리(CMOS)에는 컴퓨터의 구성 정보가 저장되어 있습니다.

Computer Setup 을 사용한 CMOS 재설정

Computer Setup 에서 CMOS 를 재설정하면 파워온 암호 및 설정 암호도 지워집니다. Computer Setup
에서 CMOS 를 재설정하려면 먼저 Computer Setup 유틸리티 메뉴에 액세스해야 합니다.

화면 오른쪽 하단에 Computer Setup 메시지가 표시되면 f10 키를 누르십시오. 필요한 경우 enter 를 눌
러 제목 화면을 생략하십시오.

주: 메시지가 나타나는 동안 f10 키를 누르지 않으면 컴퓨터를 끄고 다시 켜야만 유틸리티를
사용할 수 있습니다.

Computer Setup 유틸리티 메뉴에 File, Storage, Security, Power 및 Advanced 의 5 개 제목이 표시
됩니다.

CMOS 를 출하 시 기본 설정으로 재설정하려면 먼저 시간 및 날짜를 설정한 다음 화살표 키 또는 tab
키를 사용하여 File > Default Setup > Restore Factory Settings as Defaults 를 선택합니다. 그런
다음 File 메뉴에서 Apply Defaults and Exit 를 선택합니다. 이 작업으로 부팅 순서와 기타 기본 설정
과 같은 소프트 설정이 재설정됩니다. 그러나, 새 하드웨어 찾기는 실행되지 않습니다.

암호 재설정에 대한 자세한 내용은 Documentation and Diagnostics CD 의 데스크탑 관리 설명서를 참
조하십시오. Computer Setup 에 대한 자세한 내용은 Documentation and Diagnostics CD 의
Computer Setup(F10) 유틸리티 설명서를 참조하십시오.

CMOS 버튼 사용

CMOS 버튼은 CMOS 를 재설정하지만 파워온 암호 및 설정 암호는 지우지 않습니다.

1. 컴퓨터와 모든 외부 장치를 끄고 전원 콘센트에서 전원 코드를 뽑습니다.

2. 컴퓨터에 연결된 키보드, 모니터 및 기타 모든 외부 장치를 분리합니다.

경고! 감전이나 뜨거운 표면으로 인한 부상의 위험이 있으므로 반드시 벽면 콘센트에서
전원 코드를 뽑고 내부 시스템 부품의 열이 식은 다음에 만지십시오.

주의: 컴퓨터에 전원이 연결되어 있으면 장치가 꺼진 상태에서도 전원 공급 장치는 항상
시스템 보드에 입력되는 전압을 유지하고 있습니다. 전원 코드를 잘못 뽑으면 시스템에 손
상을 줄 수 있습니다.

정전기는 컴퓨터나 장비(선택 사양)의 전자 부품을 손상시킬 수 있습니다. 아래 절차를 시
작하기 전에 접지된 금속 물체를 손으로 잠깐 만져서 정전기를 미리 방전하십시오. 자세한
내용은 Documentation and Diagnostics CD 의 안전 및 규제 정보 설명서를 참조하십시오.

3. 컴퓨터 커버나 액세스 패널을 엽니다.

주의: CMOS 버튼을 누르면 CMOS 값이 출하 시 기본값으로 재설정됩니다. 나중에 필요
할 것을 대비하여 재설정하기 전에 컴퓨터 CMOS 설정을 백업해야 합니다. 백업 시
Computer Setup 을 사용하면 편리합니다. CMOS 설정을 백업하는 방법은
Documentation and Diagnostics CD 의 Computer Setup(F10) 유틸리티 설명서를 참조하십
시오.
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4. CMOS 버튼을 찾아 5 초 동안 누릅니다.

주: 콘센트에서 AC 전원 코드가 뽑혀 있는지 확인하십시오. 전원 코드가 연결되어 있
으면 CMOS 버튼을 사용하여 CMOS 를 지울 수 없습니다.

그림 B-1  CMOS 버튼

주: CMOS 버튼과 기타 보드 구성 요소를 찾으려면 해당 시스템을 위한 IPM(Illustrated
Parts Map)을 참조하십시오.

5. 컴퓨터 덮개나 액세스 패널을 다시 장착합니다.

6. 외부 장치를 다시 연결합니다.

7. 컴퓨터에 전원을 연결하고 켭니다.

주: CMOS 를 지우고 재부팅하면 구성이 변경되었음을 알리는 POST 오류 메시지가 나
타납니다. Computer Setup 을 사용하여 날짜, 시간과 함께 모든 특수 시스템 설정을 재설
정합니다.

Computer Setup 에 대한 자세한 내용은 Documentation and Diagnostics CD 의 Computer Setup(F10)
유틸리티 설명서를 참조하십시오.
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C 드라이브 보호 시스템(DPS)

DPS(드라이브 보호 시스템)는 일부 컴퓨터에 설치된 하드 드라이브에 내장되어 있는 진단 도구입니
다. DPS 는 보증되지 않은 하드 드라이브 교체로 발생할 수 있는 진단 문제를 지원하도록 설계되었습
니다.

이 시스템이 내장되어 있으면 설치된 각 하드 드라이브는 DPS 를 사용하여 테스트되고 키 정보가 드
라이브에 영구적으로 기록됩니다. DPS 가 실행될 때마다 테스트 결과가 하드 드라이브에 기록됩니
다. 서비스 제공 업체는 이 정보를 사용하여 DPS 소프트웨어가 실행되었던 상태를 진단할 수 있습니
다.

DPS 의 실행은 하드 드라이브에 있는 프로그램이나 데이터에 영향을 주지 않습니다. 테스트는 하드 드
라이브 펌웨어에 상주하므로 컴퓨터가 운영체제로 부팅되지 않더라도 실행할 수 있습니다. 테스트 실
행에 필요한 시간은 하드 드라이브 제조업체와 크기에 따라 다르지만 대부분의 경우 기가바이트당
약 2 분 정도 걸립니다.

하드 드라이브에 문제가 있으면 DPS 를 사용하십시오. 컴퓨터에 SMART Hard Drive Detect
Imminent Failure 메시지가 표시되는 경우에는 DPS 를 실행할 필요 없는 대신 하드 드라이브 상의 정
보를 백업하고 서비스 제공업체에 문의하여 하드 드라이브를 교체하십시오.
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Computer Setup 을 통한 DPS 액세스
컴퓨터가 제대로 켜지지 않으면 Computer Setup 을 사용하여 DPS 프로그램에 액세스하십시오. DPS
에 액세스하려면 다음 절차를 수행하십시오.

1. 컴퓨터를 켜거나 다시 시작합니다.

2. 화면 우측 하단에 F10 Setup 메시지가 나타나면 f10 키를 누릅니다.

주: 메시지가 나타나는 동안 f10 키를 누르지 않으면 컴퓨터를 끄고 다시 켜야만 유틸리
티를 사용할 수 있습니다.

Computer Setup 유틸리티 메뉴에 File, Storage, Security, Power 및 Advanced 의 5 개 제목이
표시됩니다.

3. Storage > DPS Self-Test 를 선택합니다.

컴퓨터에 설치된 DPS 진단 가능 하드 드라이브 목록이 화면에 나타납니다.

주: DPS 가 진단할 수 있는 하드 드라이브가 설치되어 있지 않으면 화면에 DPS Self-
Test 옵션이 나타나지 않습니다.

4. 테스트할 하드 드라이브를 선택하고 화면의 지시에 따라 테스트 절차를 수행합니다.

테스트를 완료하면 다음 세 가지 메시지 중 하나가 표시됩니다.

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 또는 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 ~ 14

테스트가 실패하면 완료 코드를 기록하고, 컴퓨터 문제를 진단할 수 있도록 서비스 제공업체에 알려야
합니다.
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